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Editorial 

Welcome

Thank you and congratulations for choosing a product from our multimedia garment decoration
suite, Design Era.
We have put our best effort developing this product, as we have been doing for the last 20
years, to always offer you the most advanced and competitive system on the market.
We hope you enjoy it.

About this Manual

Design Era is a multimedia garment decoration suite currently integrated by two products, Stitch
Era,  a  full  featured  embroidery  design  system  and  Hotfix  Era,  a  powerful  design  product
focused on garment decoration with thermofixed materials like rhinestones and sequins.

Hotfix Era allows you to create impressive designs quickly and easily. 
The  advanced  user  interfase,  unique  in  the  market  for  this  kind  of  product,  is  based  on
contextual ribbons that displays, all the time, just the tools you need to work with the selected
object, no matter if it is a raster image, a vector graphics or a hotfix object.
The Universal Selection Tool simplify the way you work: just one tool to select almost any type
of object.
Powerful artwork tools let you use raster images and vector graphics and convert them to hotfix
objects directly with a few clicks.
Several styles for beads placement,  design simulation with a beads library with more than 3000
elements using realistic models with all their shines and texture, are just a few of the features
you are about to discover.

Chapters 1 and 2 are dedicated to introduce some notions about the hotfix technique,  the user
interfase and the conceptual elements on which the product is based.
Chapter 3 includes information about the tools for working with artwork graphics: raster images
and vector files and objects.
Chapter 4, probably one of the most important ones, is focused on hotfix objects creation and
edition.
Chapter 5 is dedicated to a very powerful Hotfix Era object: Texts
Chapter 6 contains information related with  the several  output modes available for different
hotfix production techniques: manual placement, stencils produced with vinyl or laser cutters
and automatic setting machines.
Finally, Chapter 7 shows how to work with an advanced creation tool called Smart Design.
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HotFix Era Basics

Starting HotFix Era 
When  you  start  HotFix  Era  from  the  desktop
shortcut icon or from the programs list of the start
menu you can see the software splash screen. If it
is the first time you run the application, it will appear
the welcome screen as shown in the picture on the
right, showing at the bottom the legal notes. Take a
couple of minutes to read it, and if you agreed with
the terms and conditions of the license, then click
'Yes' to complete the HotFix ERA load.

Check in the “Please, do not ask me again" box, if
you want to avoid this step the next time you run the
program.

Once the program is 
loaded, the first screen is
displayed.

This is the “File-Open” 
page.

The other functions, like 
Save, Info and Print, will 
become available in this 
tab as soon as you open
a file on screen.

This chapter will explain 
how the available tools 
are organized (i.e. how 
to navigate within the 
program).

It is very important to recognize each part of the program screen. To do so, on the “File-Open”
tab, under the “New” section, click on “Blank Design Document”.
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(1) On the top of the screen is the TITLE BAR. That bar shows the application name (HOTFIX

ERA)  and  it  may  also  show  small  buttons,  which  are  shortcuts  for  several  program

functions. This is the Quick Access Toolbar. 

It contains very frequent used commands like Save,

Undo/Redo,  Clipboard  (Cut,  Copy,  Paste  and

Delete) and Generate (recalculate hotfix objects).

This handy element is always visible and avoids you to switch ribbon tabs or access the

Application menu for accessing these commands.

(2) Below the TITLE BAR, is the TABS BAR. That bar shows the names of groups of thematic 

functions. You will find the tabs FILE, HOME, ARTWORK, HOTFIX and VIEW.

(3) Below the TABS BAR is the RIBBON BAR. This bar shows the available tools for the 

selected tab (group name). When the tab is changed, the ribbon changes accordingly.

(4) Below the RIBBON BAR you will find a bar which we will call AUXILIARY BAR where you 

have some useful functions handy like Create Sections; Select Objects; Smart Design; 
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Zoom tools; and some visual aids like guidelines, grid and subgrid; object guides and 

hide/show commands. On the right side of this bar there are some tabs to show/hide/block 

different design layers (Auxiliar; Screen Printing; Cutter; Embroidery; Hotfix).

(5) Below the previous bar is the DOCUMENT BAR. This bar also includes tabs. Each tab 

represents a document (a design) and has a different color. 

(6) Below the DOCUMENT BAR is the WORKSPACE. When a document tab is selected, this

space is the area where the design is displayed.

Walking around the User Interface

Before learning each part in detail, let´s navigate around the program for a while, in order to
understand the program organization and make it easier to find the tools.

Click on the tab NEW DOCUMENT of the document bar.

Several things occur:

A new design 
document is created 
(name Design1)

An empty workspace 
is displayed

All tabs appear in the
tabs bar (HOME tab 
is selected)

The ribbon bar 
shows the 
tools/functions of the 
HOME group
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Click on the HOTFIX 
tab and see how the 
tools/functions of that 
group appear on the 
ribbon bar.

Then click on the VIEW
tab and see how the 
tools/functions of that 
group appear on the 
ribbon bar.

These are not  the only  available  tabs of  the  TABS BAR. According to  the  activity (design
creation, editing, etc) new CONTEXT BARS may appear.

As an example:

Click on the artwork tab

Click on the Shapes tool 
and select the advanced 
shape which tooltip says 
AAS_013.

Click on any place of the 
workspace and (without 
releasing the mouse 
button) drag the mouse 
to other position and 
then release the mouse 
button.

You can see that:
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A geometric 
shape was 
created.

It is selected.

New context 
tabs are 
available 
(Vector, Layout) 
with more 
tools/functions 
available. Those 
tools/functions 
will apply to the 
selected shape.

This was only an example of how context tabs become available according to the activity and
according to the selected objects. The same concept will apply to hotfix objects. The tools are
well organized and become available when they are required.

Let´s continue with the 
FILE TAB.

In the File-Open group 
you will find three 
different sections:

New, Open and Import.

Inside the New section 
you have the 
commands to create a 
new design document:

Blank Design 
Document; Simple 
Wizard; and Complete 
Wizard Hotfix.

Inside the “Open” section you have the  command “Open a Design Document”.

Finally, inside the “Import” section, you have the commands: A Graphic File; and A Hotfix file.
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On the far right  you will  find the samples of  the recently opened documents,  which  a little
thumbnail and the physical location of the file. Double click on any to open it.

Section FILE-SAVE includes 
functions to save (store) the 
active design (current design
document) in the system 
native format: “Save the 
Design Document” and 
“Save... as”; 

and / or export the design 
(Vector, Bitmap, or Hotfix) in 
any compatible machine 
format, send the active 
design directly to the 
machine for production, etc.

Section FILE-
INFORMATION includes 
several functions related to 
the properties of the active 
design (Infocard); also

allows  you  to  Share  your
design in Social Networks;

and lets you make estimates
of  hotfix  pricing  and
production  (optional
features)
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Section FILE-PRINT 
includes several 
printing functions for  
Hotfix designs.

Section FILE-
OPTIONS includes 
functions related with
the setting of the 
software application 
(it is not related with 
the active design 
itself).
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Click on “Preferences 
Setup”. A dialog box will 
open.

On the left panel, click on
the Application group.

The right side will show 
the contents of it.

Click on Language to 
unfold a list of available 
options. 

Then choose the 
selected option from the 
setting list (right side).

This function will require 
to exit the program, and 
restart it.

There  are  several  aspects  of  the  user  interface  and  system  behavior  you  may  configure
according to your preferences. The Options and Preferences box groups all the configurable
items in HotFix ERA.

Let´s return to the FILE tab, last section.

Section FILE-ACCOUNT 
includes the information 
of the licensed software 
product, activation status,
registered user 
information and Contact 
links.

Up to now we have described the basics of the user interface. Following sections will explain
the mentioned parts with more detail.
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Artwork Tab Tools, organization

Click on the tab NEW DOCUMENT of the document bar.

 A new tab will be created (Design1) in the document bar,

 The workspace (active design) is empty.

Click on the ARTWORK tab.

The MAIN ARTWORK TAB 
(and main artwork ribbon bar)
will appear on screen.

Click on the Shapes tool and 
select a Basic Shape 
(rounded rectangle).

Click on any place of the 
workspace and (without 
releasing the mouse button) 
drag the mouse to another 
position and then release the 
mouse button.

The corresponding shape will
appear on the screen.
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ARTWORK

Artwork is the part of the design document which includes the set of graphic elements of the
design (raster images or vector graphics). In the example above, only the created vector object
is the artwork of our design.

ARTWORK CONTEXT TABS (1)

More tabs are visible in the tabs bar. The new tabs are context tabs because they depend on
the current activity of the program. As we are working with Vector Artwork (graphic shapes /
figures), then related (or context) tabs are available: VECTOR and LAYOUT.

ARTWORK RIBBON BARS (2)

When you  select  each  of  those  context  tabs,  the  ribbon  displays  all  the  related  functions
grouped in sections. The functions will apply to the object selected on the workspace. In this
moment you are able to edit any of the vector objects present on your design or create more
vector objects. These functions will be explained later.

ARTWORK AUXILIAR BAR (3)

Below the RIBBON BAR you will find a bar which we will call the AUXILIARY BAR where you
have some useful functions handy like Create Sections; Select Objects; Smart Design; Zoom
tools;  and  some visual  aids like guidelines,  grid  and subgrid;  object  guides and hide/show
commands. On the right side of this bar there are some tabs to show/hide/block different design
layers. The first led, Auxiliar, corresponds to the image/s you have on screen.

ARTWORK COLOR BAR (4)

On the left of the workspace, a vertical toolbar shows some tools related to the color palette of
the artwork and other tools.

If you want to set the color to create an object, or edit (modify) the color of an existing object,
you can press the left mouse button on any color of the color palette to set the fill color (area)
and/or the right mouse button to set the border color (line).

If you want to change the color palette (colors displayed on the left of the workspace) you can
set each color with the color palette function (there is a palette icon) in the artwork color bar.

These functions will be explained later.

The same concept of new context tabs with related functions in the ribbon bars apply to Hotfix
objects. The tools are well organized and become available when they are required.
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Hotfix Tab Tools, organization

Click on the tab NEW DOCUMENT of the document bar.

 A new tab will be created (Design1) in the document bar,

 The workspace (active design) is empty.

Click on the HOTFIX tab

The MAIN HOTFIX TAB 
(and main hotfix ribbon 
bar) will appear on 
screen.

There are many hotfix 
tools. At this time we will
only show how to use 
one of them.

Let’s create an area with hotfix.

To do so, on the Insert Hotfix Objects
group, click on Single Hotfix Fill (input
method)  and select  Area with  Hotfix-
Uniform  Fill  from  the  list  of  hotfix
styles.

Note: as you can see in this picture, 
HotFix Era has a huge set of tools 
(among others, many hotfix fill styles) 
but they may be not available in all 
software products (or software levels).

The official website offers information 
about the features available in each 
software product.
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Click (mouse left button) on several points of the workspace. To close an object, simply locate
the last point above the first point. The system will  close the area automatically.  To close it
manually, you can either press the Enter Key or click the mouse center button. This will confirm
the hotfix object and will show the corresponding beads (rhinestone, sequin/spangle).

HOTFIX

Hotfix is the part of the design document which includes the rhinestone and sequin/spangles
objects. In this case, only the created hotfix object is our hotfix design.

HOTFIX CONTEXT TABS (1)

More tabs are visible in the tabs bar. The new tabs are context tabs because they depend on
the current activity of the program. As we are working with Hotfix, then related (or context) tabs
are available: HOTFIX AREA BODY, BORDER & LAYOUT.

HOTFIX RIBBON BARS (2)

The context ribbon bar shows the group of functions of Hotfix Area input method, with Uniform
Fill. There are many many context ribbon bars as there are many input methods and hotfix fill
styles. The functions will apply to the hotfix object selected on the workspace or to a new hotfix
object under construction. These functions will be explained later.

HOTFIX AUXILIAR BAR (3)

Below the RIBBON BAR you will find a bar which we have called AUXILIARY BAR where you
have some useful functions handy like Create Sections; Select Objects; Smart Design; Zoom
tools;  and  some visual  aids like guidelines,  grid  and subgrid;  object  guides and hide/show
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commands. On the right side of this bar there are some tabs to show/hide/block different design
layers. The hotfix led,   corresponds to the hotfix object/s you have on screen.

HOTFIX BEADS BAR (4)

To the left of the workspace, there's a vertical toolbar that shows some tools related to the
beads (rhinestone, sequin/spangle) palette of the hotfix design and other tools.

If you want to set the type of bead to create a hotfix object or edit (modify) the type of bead of
an object, you can press the mouse left button on any bead to select that bead type.

If you want to change the beads palette (beads types displayed on the left of the workspace)
you can set each bead with the beads palette function (there is a palette icon) in the hotfix
threads bar.

These functions will be explained later.

Understanding Working Modes
There are 4 main working modes:

Design Creation

Also known as Digitizing or Object Creation.

In this working mode, users are able to insert many objects in the design.

There are many kind of objects. We classify them in 2 types:

 Graphic/Vector Objects

 Hotfix Objects
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Example:

Create a new design document as described previously

Select the HOTFIX tab.

The program will show 
the MAIN HOT FIX 
ribbon bar.

Click on the Hotfix Objects group:

Single Hotfix Fill

The program will show the available Fill Styles.

Select the Hotfix Style:

Area with Hotfix – Uniform Fill

The program will  show the Area with Hotfix –
Uniform Fill  ribbon bar.

Let's make some adjustments on the properties of the area we are going to do, just by working
on the ribbon. These adjustments will apply to the objects we are creating.
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Click on the small arrow on the right of Manual (Digitizing Methods group),
and select  Arc Nodes.  Now click on the  Curve function (Digitize Object
group).

Click on the bead sample (in this case the Rose color 4ss) to open the 
bead selector (right capture). It will show you the available beads with their
sizes and colors.

We have clicked over the  6ss Aquamarine color, Round Rhinestone. The 
change will be automatically updated on your ribbon bar. 

Now you can insert the area's reference nodes.

On  the  workspace,  make  several  mouse  left  clicks  in  different
precise positions (each mouse click adds a node to the object in
construction), creating a circle (or any other shape). Make the last
click over the first node to close the shape.

Finally, hit Enter to confirm the created object.

The program will generate the hotfix beads.
Note: To confirm you can also click the mouse center button or from the context menu
choosing Accept / OK.

 

Press F7 to see the object just created in Simulation mode.

Now you can click on the MAIN HOTFIX tab and start creating a
second embroidery object of any kind.
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Different ways of selecting the same object kind.

You have several ways of enabling the same Hotfix creation tool object:

1 From the  Hotfix  ribbon >  Insert Hotfix
Objects  group  >  choose  the  type  to
unfold the list of available styles. Click
on the desired one.

2 Selecting it from the  Design Creation
mode button.

Click on the small arrow on the right of
the Design Creation mode button.

Then select the object type and finally
the  style  to  use  from  the  pop-up
menus.
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3 Selecting it from the Smart Design 

tool.

Click on the Smart Design button.

Then select the object type and stitch 
style to use from the Smart Design 
tool.

Digitizing Modes:

Up to now we have used only the manual digitizing mode (click node by node). There are some
details you must know about this digitizing mode, and you must also know that there are other
digitizing modes (they may vary according to the software product):

 Manual Digitizing (arc curves, bezier curves)

 Automatic Digitizing (auto-trace, auto-complete, etc)

 Geometric Shapes (regular shapes, auto-shapes)

 Free Hand Digitizing

These digitizing modes will be explained in following chapters.

Conclusion. Important Concept:

 An object is the simplest element we can insert in a design. The object is defined by a
shape (contour, holes, etc) with auxiliary elements, and by the properties.

 We insert  hotfix  objects  in  a  design because it  is  easier  and faster  than  inserting
stones or sequins one by one. When you insert a simple circle and define the hotfix
properties (stone spacing, etc) the program converts that object into stones or sequins.

 If  you save the design in the system native format DSG, that  format keeps all  the
information of the objects (shapes, properties, etc.).  You may then edit (modify the
shape and properties) at any moment easily.
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 Instead, when you save the design in a machine file format (also known as expanded

formats), that format only knows about stones/sequin, and the useful information of the
object is lost.

System formats include Hotfix Objects.

Expanded formats (machine formats) include Hotfix beads.

Object Editing

This is the second working mode. When you have a design made by several objects, you are
able to  edit  every characteristic  of  those objects:  You can change the shape of  an object,
enlarge reduce and move it, and modify each property in the same way you did when the object
was created.

Press the Select Object 
tool (to enter the object 
editing mode).

Select  an  object  or  a
block  of  objects  in  the
workspace. A surrounding
rectangle  will  cover  the
object/s.

Now, you can execute any of the object editing functions, among others:

 Move the object (drag and drop the rectangle)

 Re-size the object (move the rectangle handlers)

 Rotate the object (press the CTL key and move the rectangle handlers)

 Change the shape of the object (drag and drop the nodes of the object)

 Modify any of the elements of the object 

 Change any of the fill properties (from the ribbon bar, or from the object inspector)

After you edit a hotfix object, the program will re-generate the stones/sequins according to the
new object features.
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As explained, when the design is made of objects, then object editing is very powerful to modify
existing designs. It  uses the generation engine to rebuild objects. By contrast, hotfix editing
(stone by stone) is more complicated, slow, and it doesn't use the generation engine of this
software to rebuild design parts.

Smart Design

This is the third working mode. This tool simplifies the steps and speeds up the object creation
or edition process, as well as some functions related with the auto-digitizing feature over vector
objects.

Press the Smart Design 
tool (to enter the Smart 
Design mode).

A window with the tabs  
Hotfix; Edition and Creation
will open.

Click on the Creation tab to
see the available tools to 
build a new object; 

Click on the Edition tab and
select an object, to be able 
to... 

...convert it from vector  
object into and embroidery 
(or Hotfix) object; 

... convert the kind and fill 
of an embroidery (or Hotfix)
object to a totally different 
one, among the available.

If your software product has both embroidery and hotfix features, this tool allows the conversion
of embroidery objects into hotfix ones and viceversa.

This working mode will be explained in Chapter 7 - The Smart Design Tool.
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Hotfix Editing

This is the forth working mode. Also knows as Expanded Editing. Sometimes you need to edit
stones  on  a  hotfix  design.  Certainly  HotFix  ERA  includes  the  tools  for  expanded  editing.
Expanded editing is required when the design is not made of objects, this is the case when the
designs are imported from commercial machines file formats. However expanded editing can
also apply to objects if fine tuning is required.

Press  the  Edit  Hotfix  tool
(entering  to  the  hotfix  editing
mode).

Select  a  hotfix  bead  in  the
workspace. It will be surrounded
by a square.

The  ribbon  bar  will  show
information  about  the  position,
angle and bead type.

Now, you can execute any of the hotfix editing functions, among others:

 Move, delete or insert beads

 Select blocks, then move, delete, rotate, copy & paste, etc.

 Use the Repetitions group of functions (Duplicate and effects options).

Common Tools
There are some useful tools that are always available no matter what tab is active. They are
located in two groups: one above the working area which we will call Auxiliary toolbar and the
other on the right edge of the working area, called Views Panel; 

The  one  above  the  workspace  area  gathers  the  following  functions:  on  the  left:  Create
Sections, that allows to build new objects, graphic shapes, and hotfix; Select Object, used to
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select one or more objects for edition; Smart Design, a great tool for quick object creation,
edition  and  conversion  (briefly  explained  in  previous  pages);  and  visualization  tools  like
simulation view, zooms, pan and hide/show options; 

On the right you will find some very helpful led lights, one for each document type you are
using  and  each  with  its  corresponding  tab  in  the  Document  Map.  You  have  Auxiliary;
ScreenPrinting; Cutter; and Hotfix. They allow you to Hide, Show or Lock the objects that form
your design to easier your designing process.  

Auxiliary toolbar will be explained in the next Chapter.

Views Panel – Object Manager

Located on the right side of the workspace area, the Views panel allows you to explore the
structure of your designs, that is, the sequence of entities the design is built of. 

The main view is the Object Manager. It contains a panel with a map of the design, divided in
object types, and section by section, with predefined fill modes. 

Below is  the  Object  Inspector,  which  shows  the  complete  list  of  properties to  be  able  to
control, in detail, how the system will generate the beads for your hotfix designs.

When you click on a section on the Object Manager, the Object Inspector shows all the related
properties to the object selected.

Another important view is called Hotfix Objects. It shows a
Sequence of  all  the Hotfix Objects present in the design,
and below it, a list of all the design´s hotfix beads.

The last view, called Vector Objects shows a list of all the
vector objects present in the design.
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Catalog

There's also another group gathered in a floating window that
remains open once you click on its access, named Catalog. It
is  located  on  the  HOME ribbon,  INSERT group.  It  allows
graphic browsing of all the media handled by your software
so you have quick access to it. It´s divided in three panels.
The upper one shows the media type: Images (Raster and
Vectors);  Native  Designs  (DSG  files);  Hotfix  Designs
(machine  format)  and  Motifs  (predefined  files  ready  to  be
used);

Having selected the media type, the second panel, named
“Folders”  shows  the  available  folders  on  your  computer.
Navigate through your disk units and folders until you find the
one needed. The third panel,  named “Images”, will  display
the contents of the selected folder graphically.

Find the desired object and just drag it into the workspace to
load  it.  Don’t  worry  about  the object  type,  the system will
recognize it and will proceed properly. 
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The File Page and Ribbons

In this chapter you will learn about the basic commands you need to open hotfix files and use the
large set of visual tools available to explore the design, manipulate its colors, access detailed
information and generate printouts. 

The File Page
Once the program is loaded, the File Page will open. 

The first screen to be displayed shows the File - Open commands. You have other commands
grouped in the File page besides Open. They are Save; Information; Print; Options and Account.
We will see them in detail in this chapter.

File - Open

From this command you can load all types of designs (expanded and condensed) into Hotfix ERA.

It offers several options to start your work, which are gathered within the following group names:

• New; 

• Open a Design Document; 

• Import;

• Recent Documents;

New 

Blank Design Document: Opens a new working window ready to start working.

Simple Wizard: Use this option to create new designs by just indicating the  design
name, storage folder, design authoring information, classification, job order, and price.

Complete wizard Hotfix: This option will prompt you to specify design name, storage
folder,  design authoring information,  classification,  job order,  price,  and hoop to be
used. Some information is optional and other is required. 

Open a Design Document

Open a Design Document: Displays an Open Design dialog so you can browse your
units and folders and select the design (condensed format) you want to open, in a new
working window.
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Import

A Graphic File: You can open a Raster or Vector Image into a new document, as well
as getting an image file directly from Corel DRAW or Adobe Illustrator.

A Hotfix File: Open an already made hotfix file into a new document.

Recent files

Shows a graphical preview of the last recent designs loaded, so you can double-click 
on any to quickly re-open it.

After you click on any of the available options, a window may open. 

- You can browse your units using the left panel and the Look In control available
in the toolbar.

- You can switch the view mode to icons, list, details, several thumbnails mode, etc

- You can select the codes to be displayed or use the All Files filter to indicate
Hotfix ERA to display all types of embroidery files.

To open a design just double click on it (or select with one click and press the Open button).
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File - Save

From this command you can save  (store) the active design (current design document)  in the
system native format, export the design in any compatible machine format, send the active design
directly to the machine for production, etc. 

It offers several options to start your work, which are gathered within the following group names:

Save 

Save the Design Document: Save the Design Document to save a Design format file
also known as condensed file. You can save Sierra Designs (DSG files)

Save the Design Document as...: This option will save a copy of the working window
with another name.

Export

Vector Graphics

Bitmap Graphics

Hotfix

When you click on any of the options, “Export As” will list the available choices.
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When you finish your work with a condensed design, save it for the last time to keep the last
changes made and use the Export command to prepare it to be sent to your machine.

If later, you need to make some changes, open the dsg file (condensed), make the changes,
save the dsg file and export it again. 

This procedure may sound too indirect at this point but, as you will discover in the following
chapters, dsg files are much easier and flexible to modify than expanded design files. 

The whole idea is to work, all the time, with dsg files and export them into expanded files just
before sending them to the machine.

Note 1: Hotfix Era offers an auto-backup feature that automatically saves the active design at a regular time interval 
(specified in File – Options - Preferences Setup – Project – General). However, it’s a good practice to save the design 
by yourself once you have complete a  task you consider important during the design process.

File - Information

From this command you have access to four different groups that have to do with the design
information, sharing and production calculation. 

Information

◦ Design Properties (Infocard):  Shows a summary of the design properties including
information of authoring and classification.

◦ Hotfix Properties (Infocard): Shows a summary of the hotfix properties. 

Share

◦ Share the Design in Social Networks: You can upload the design on the work window
along with a comment via Twitter.

Product Calculation

◦ Hotfix Database Price Setting: Allows setting the prices of hotfix to be used in costing
calculation.

◦ Hotfix Pricing: Calculate Hotfix design cost based on prices of hotfix configured.

We will see each one in detail.
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Information-Design Properties (Infocard)
It is divided in three tabs: General; Job and Authory; Category.

General tab
Contains basic design file information such as design name, file name, storage path, file size,
creation date, last edition date and file attributes.

Job and Authory tab
Using this tab you can add job order and design author Information. 

Data related with job order includes order number, requesting and creation dates, customer name
and time used (computed automatically)

Author information includes design codification, owner, author, copyrights, etc.

Category tab

Last, the Category tab allows to establish information about Collection, Category and Keywords
which will be assigned to the design. All this data will be very useful for those design saved in the
Design Library.

To add information follow these steps: 

Collection – To add a new collection, clic on the
ellipsis  button  [···],  which  is  marked  on  the  left
figure. 

The Collection  Editor  box  opens,  type  the  name
and press the green check button to finish inserting
it to the system, it will be listed in the Collection list,
clic on the OK button to confirm the Collection just
inserted.

 2 - 7



Hotfix Era – User's Manual

Category –  It  is  a  hierarchy tree.  To assign the
design a determined category, simply select it from
the list. 

In the case the Category does not exist, enter the
Category Editor through the ellipsis button [...] and
type the adequate category. 

From this box you can create and delete items and
sub items through the corresponding buttons (see
left figure).

Keywords  -  Keywords  are intended for  helping  searches.  A keyword  is  a  descriptive  word
(normally just one word) related to the design thematic. A design may contain several keywords.
You can add keywords using the Keyword editor (ellipsis button).

Information-Hotfix Properties (Infocard)
It's divided in two tabs: General Information and Sequence.

General Information tab

It´s  divided  in  two  panels.  Left  panel  includes
general  design  data  such  as  Width,  Height,
number of different types of beads and Quantity.

The right panel shows a simulation view of the
design.
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Sequence

Within this tab you will find on the left a sorted
list with a graphic view showing the beads color
in the design in the order they will be processed.

The thumbnails also contains information about
the bead diameter.

On the right you will find a simulated view of all
the design, but highlighting the bead type you
selected on the left panel. 

Share-Share the Design in Social Networks

This option allows you to upload the design that is on the work 
window to the Social Networks - Twitter.

You may add a comment along with the design.

Follow these steps:

With the design you want to upload on your active document 
windows, go to the File-Information tab, then to the Share group, 
and click on Share the Design in Social Networks.

Information-Product Calculation (Optional Feature)

Hotfix Era includes tools to prepare hotfix service quotations.

You  can  access  these  tools  from the  File  –  Information  -  Product  -  Calculation  menu,  and
selecting any of the items: Hotfix Database Price Setting or Hotfix Pricing.
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Hotfix Database Price Setting

This  dialog box lets you add a price to any of the listed bead types, for a later use in pricing
calculations.

Use the Type, Shape and Size filters to be able to find a desired bead easily on the list.

From the  Type list you can
select among Rhinestones,
Rhinestuds,  Nailheads,
Sequins and Spangles.

From  Shape you  can
choose  the  geometry  you
are looking for among: Std-
Heart;  Std-Octagon;  Std-
Oval;  Std-Rectangle;  Std-
Round;  Rim-Round;  Std-
Square and Std-Star.

Once  you  selected  the
bead Type and Shape, you
will  be  able  to  find  the
dimensions available on the
Size list.
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Once you find the desired bead, select it by checking its corresponding box. Insert the Volume
(number)  ,  and  Price  x  Volume and  press  Apply.  The  system  will  automatically  update  the
information on the list.

Hotfix Pricing

This tools is specialized to prepare hotfix service quotations based on design information, beads
count and price values you define.

To determine a price for your design follow these steps:

1. Open the hotfix design on screen. 

2. From File > Information > Product Calculation , choose Hotfix Pricing.

3. The Hotfix Cost dialog box will open showing the total cost of the selected design.

If any of the items shown on the Hotfix Cost dialog box do not have Qty. and/or Price, or you
want to update any of the values, you can set them through any of the following ways...

• From the Hotfix Database Price Setting (previous page) …

but more directly...

• From  Prices button, to  open  the  Pricing window with  only  the  beads  used  for  the
selected design. Select each type, insert Volume and Price, and press Apply.

• From Set price for selected bead button. On the Hotfix Cost dialog box, click on one of
the items to highlight it. Upon pressing the button, the Set Price dialog box will open.
Insert Volume and Price, and press Apply to update the information.

• From the Hotfix Cost dialog box, you can print the Pricing information of the design.

 2 - 11



Hotfix Era – User's Manual

File – Print

Hotfix Era offers two methods for printing your designs: Standard Print and Hotfix Draft Printing.
The Standard Print allows a general, simple layout, with a quick setup, while Hotfix Draft Printing
prints the Hotfix design in draft mode for manual stone positioning. 

Standard Printing

To print the active design, just use the Print command from FILE – PRINT – PRINT DESIGN. The
Print  box  allows  you  to  select  basic  printing  parameters  for  the  design  picture  and  for  the
information to be printed with it.
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Scale: This parameter refers to the size of the design in the paper sheet. Use 100% to get a full
scale, 1:1 print out

Print rotated: When checked, the design is printed in landscape mode.

Print Hotfix - Simulation: When checked, the design is printed in simulation mode.

Print Design Information:  Check this box to include an information area in the printout. The
marks Full file name, Customer and Owner allows you to set what extra information should be
included.

Print Page Border:  Check this mark to force a thin box to be printed all around the layout.

Note: Use the Preview button to check how the printout will look before printing. Use the controls at the lower right corner to 
control page margins and set printer preferences.
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Hotfix Draft Printing

Use the option Hotfix Draft Printing to print  the Hotfix design in draft mode for manual stone
positioning.

To print the active design, just use the Print command from  File ribbon >  Print >  Hotfix Draft
Printing.

The  Hotfix Print Export  dialog box will  open (next figure). It allows you to select basic printing
parameters for the design picture and for the information to be printed with it.

This command lets you  print  placement  sheets to use them, for example,  as a reference for
manual placement:

 Print the placement sheet.

 Put  a  transparent  transfer
sheet  (adhesive  up)  over  the
placement sheet.

 Manually set  the pieces using
the  placement  sheet  as
reference.

 Set  the  transfer  sheet  on  the
garment and apply heat.
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The print dialog is organized in two tabs:

Page design: 

Lets you control the reference elements that 

will  be  printed:  information  header,  design
frame,  alignment  marks,  design  rotation  and
general scale.

Beads: 

Includes two lists: A bead types list at the left
and a Pages List at the right. You can change
the Marks visualization and colors among the
options given, to be able to locate them easier.
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File – Options

Hotfix Era lets you customize many topics related with the interface look and system behaviour.
All the configurable options are managed from the FILE tab, OPTIONS section.

These options include functions related with the setting of this software application.

Options  and  Preferences  show  three
possible customization choices:

 Preferences Setup. You can
make some  adjustments  on
the  program  to  suit  your
needs.

 Customize  Shortcuts.  You
can  modify  some  of  the
predefined  function  keys  to
work faster on your designs.

Preferences Setup

The  Options  and  Preferences  box
shows a tree where  the configurable
options  are  organized  in  categories
and topics.

Your settings will be saved when you
press  the  OK button  and  will  be
preserved permanently.

The  following  paragraphs  contain  a
brief  description  about  the
configurable options:
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Application

This category contains settings to set the preferences about:

1. Live Update: When enabled, the system checks for  updates, services packs, news
and special offers available for your product.  This option requires internet access.

2. System language

3. Skin name: you have a list of available skins to choose from, to change the 
appearance of your software.

4. Users Resources path: to set the location of the components made by the user.

Project

General: This  category  contains
options  to  control  how  the  system
starts. 

Units: Lets  you  select  the
measurement units used for different
elements.  Click  the  numbers  in  the
Group column and  review the  brief
description,  indicating  the  elements
the units apply to.

Hotfix: This  category  allows  you  to
configure what kind of beads will be
shown  (Rhinestones  /  Rhinestuds  /
Nailheads / Sequins / Spangles), the
cutting margin and the way of sorting
them.

Workspace

Within this category you will  find options to manage the appearance of the workspace and
visual aids, and the behaviour of some visual tools.

General: Options for rulers, large cross cursor and ribbon fitting in 1024 pixels wide screens

Limits: Set the max. workspace size and decide if the work area is limited to the workspace
(system will not allow you to place objects outside the workspace if you check the option)

Visual Aids: This group lets you control de Guidelines (or Reference lines) position and colour
and to define the Grid and Sub grid look and behaviour

Object References and Marks:  Controls in this group allow you to define the visual aspect
(color,  transparence,  etc.)  of  the  marks  the  system  uses  to  represent  nodes,  sections
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references, etc. 

Zoom: Use these controls to define the zoom factors and use of mouse wheel for zooming.

Auto scroll: This group controls the automatic scrolling feature: region size, speed, etc.

Video card Settings:  These are important settings related with the performance of your display
system. If you are using a good video card, you will want to set the Video hardware acceleration
to  the  highest  value  to  get  faster  screen  redraws.  It  is  also  recommended  to  activate  the
Enhanced line drawing. 

Some video cards may be not fully compatible with OpenGL implementation, and you might experience abnormal screen
redraw. Lower the Video hardware acceleration value. Set value to zero, if video card is totally incompatible with OpenGL.

Create and Edit

This category includes the available customizable options for edition and creation tools and to set
some general features of stitch generation and processing.

General: You will  find options to control curve types (bezier or arcs), to hide and show some
references while create or edit, to manage the Auto Generation mechanism, etc.

Snaps: Use this controls to enable or disable the snap schema and to define what snap tools you
want. Snap is useful when you need to digitize with large accuracy, for example, when creating
geometric designs.

Notifications

Into this category you will find options to configure sounds for specific events and to control the
Messages Window behaviour.

Reset to Default Values

Settings in each group can be reset to their default values by pressing the Default Setting button
located on the corresponding group. If  you  need to reset all  the configurable options to their
factory values, use the button Reset All To Default located below the tree panel.
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Customizing Shortcuts

Hotfix Era lets you customize the shortcuts for most of the commands. To do so, follow the next
steps:

1- Click on the FILE tab, then on OPTIONS group and select “Customize Shortcuts”.

2- In the Shortcuts box, locate the command you want to modify its shortcut, using the Category
and Command lists.

3- Click on the box named Shortcut, press the desired key sequence and confirm it with the
green button. Repeat these steps for all commands you need.
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Keyboard Shortcuts
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File – Account

Gives you information about
the User, installed Product,
Activation Status.

It also lets you buy Features
and Components.

You  have  contact  links  to
the  Service  Center;
Technical Assistance; Sales
Contact;  and  to  change
Registered  User  and
License Ownership.

Learning about the different Ribbons
Once you have selected any of the File-Open commands, the main view will appear. 

You will see a group of different ribbons which we named in the previous chapter. In this chapter 
we will talk about the Home and View ribbons. Artwork ribbon will be studied in chapter 3 Images 
and Vectors. Hotfix ribbon will be shown from chapters 4 to 7. 

Within Hotfix Era we call Main View to a series of
panels  and  windows  that  display  the  design
considering  different  aspects,  like  graphic  look,
entities sequence, stitches, etc. 

Most of the job with a design is done in the graphic
area we call workspace or main view.

It is the largest area in your screen and displays the
design graphically.  Every time you open a design
or create a new one, is is presented within a new
tab.  You  can  switch  among  loaded  designs  by
simply clicking on its corresponding tab. 
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The Home ribbon

Open

This group has two commands: New and Open. 

New: click on the arrow to unfold the possible options.

Simple  Wizard: Use  this  option  to  create  new
designs by indicating just the material and hoop.

Hotfix Wizard: Same as previous one.

Open: click on the arrow to unfold the possible options.

Open Design: Use this option to open a native.

Open a Hotfix Machine File: Allows opening a file
with extension YNG; DST; PLT and CSV.

Open an Stencil  File: Allows  opening  a  file  with
extension PLT.
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Catalogs

It  is  located  on  the HOME ribbon,  INSERT group.  It  is  a
floating window which  remains open once you click  on its
access. 

It  allows graphic browsing of all the media handled by your
software so you have quick access to it. It´s divided in three
panels.  The  upper  one  shows  the  media  type:  Images
(Raster  and  Vectors);  Native  Designs  (DSG  files);  Hotfix
Designs (machine format) and Motifs (predefined files ready
to be used); 

Having selected the media type, the second panel, named
“Folders”  shows  the  available  folders  on  your  computer.
Navigate through your disk units and folders until you find the
one needed. The third panel,  named “Images”, will  display
the contents of the selected folder graphically.

Once you find the desired object, step on it, and drag it into the workspace. The system will
recognize  the  type  of  object,  proceed  to  open  it  on  the  workspace,  and  visualize  the
corresponding ribbon toolbars. 

Example: We are going to open a hotfix motif named HRT-A0001. Follow these steps:

1)  Open a blank document. On the Home ribbon, Insert group, click on Catalogs.

2) 

On the first panel, click on the  to the right of the 
item Media: Images - Raster to unfold the list of other 
Media type available.

Click on Motifs – Hotfix
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3) The Media type will now show: Motifs – Hotfix

The third panel will show Motifs and beneath it you will
see all the Motifs found on the first Category (listed in
Categories).

To  see  the  contents  of  another  Category,  on  the

second panel, click on the   to the right of the item
Categories  to  unfold  the  list  of  the  others  available.
Click on the desired one to show the contents on the
third panel.

4)

Step on the motif you want. In this case, the HRT-
A001.

You have two options:  OPEN or EDIT the motif.

5a) OPEN it as a new design...

>  just  by  dragging  it  from the Catalogs  window and
dropping it on the workspace;

> double click on it on the Catalogs window, and then,
on  the  workspace,  keeping  the  left  mouse  button
depressed, move it  as you were making a rectangle.
You will  see  the design being made.  When you are
satisfied with the size, release the button.

Note: See  that  the  name of  the  document  tab says
Design4, which corresponds to a design file.

5b) EDIT the motif to make changes on it. 

When you save it, it will update the existing motif.

Create a different one by using the Save 
as...command.

Note: See  that  the  name of  the  document  tab says
HRT-A001,  which  corresponds  to  a  motif  file  being
edited.
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Undo and redo

It is always possible to undo the last actions taken, starting by the most recent,
from the Undo command.

It is also possible to access this command from the quick access toolbar or from the Ctrl + Z
shortcut. If you are not pleased with the undo result, you can restate the option from the command
Redo, or through the shortcut Ctrl + Y.

Note: Remember that in basic levels, there's a limited number of undo/redo actions.

Clipboard

During the process of making copy and paste, once you have pressed
CTRL+C, the object will remain in the clipboard until you decide to paste
the content of it  (CTRL+V). You can copy and paste raster and vector
images; design, embroidery, and hotfix objects from the clipboard.

Delete 

Use this command to delete a section or group of sections without modifying the rest of 
the design. First of all, it is necessary to select a section or block. Then, access the Home
ribbon or context menu and click on the Delete button.

Cut

This command copies the section or block selected into the clipboard and deletes it from
the current document without modifying the rest of the design.  The block cut remains in
the clipboard. Activate the command from the Home ribbon or click on Ctrl + X.

Copy

This command copies the section or block into the clipboard, without altering the current
design or deleting the original  section or block. Click on the Copy command from the
Home ribbon or click on Ctrl + C so that the clipboard holds the selected block. Then,
paste it wherever you want. 
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Paste

This  command  copies  the  clipboard  content  in  the  active  document. To  use  this
command, you must have previously copied or cut a block. Click on the Paste command.
Paste in the toolbar or press the Ctrl + V keys.

Paste in Place

This command copies the clipboard content in the active document, but exactly in the
same place of the copied object (original).

Yet, there are certain image creation applications that allow you to copy an image file type you are
working on (Windows Metafile, EMF, etc.),  to the Clipboard.  This is recommended for certain
sketches with a high level of elements, or when it is necessary to obtain more precision (better
level of detail). You may then paste it in Embroidery Office using these commands.

Format

Repeat command  lets  you  pick  up  an  object's  properties  and  copy  them  to
another object of the same kind. Press Repeat command, the cursor will turn into
a dropper. Click on an object to pick up its properties. 

The cursor will turn into a bucket. Click on another object and the properties will
be pasted over the new object.
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Work Area (Pages and Hoops)

Pages allows defining the work area as a printer/cutter sheet type (A4, Letter,
etc.).

Click on the arrow to the left of the Pages button to unfold
the available options.

You can also make a new one with your own dimensions
on “Page Settings”.

Hoops allows you to display in the workspace an schematic representation of the
hoop you will use at the time to process your design.

Displaying the hoop on screen gives you the chance to check if design will fit in 
the hoop area safely, avoiding any machine incidents, and to fix its position if 
required.

Click on the arrow to the left of the Hoops button to unfold
the available options.

From Hotfix – Machine Workspace, you can select one of 
the available ones.

From the Hotfix Hoops Database, you can customize your
hoops. Add a new one or delete an existing one.
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Once selected press OK and use the Show Hoop command located in the Home ribbon > Work 
Area group > Hoops  button, to turn the hoop on/off.

Creating new hoops

If the one you need is not among the ones available, go to Hotfix Hoops Database, and create 
one on your own.

Use the Add command (the button with a + sign located above the list at the left) to add a new
hoop.   You  will  need to  specify  a  name,  brand and code (it  will  help  to  keep your  hoop
database well organized) and, of course, the basic shape and size.

You can also specify a safety margin, that will be displayed as a dotted line around the hoop,
and will  prevent you to place stitches too closer to the hoop edge. Even more, if  you own
several machines, you may add a reference to later help you identify what machines can use
the hoop, by filling the list “Compatible with”.
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Output options

These options allow you to quickly access the commands that
are necessary for gathering information on the design you are
making;  saving  and  printing  it;  and  sharing  it  by  e-mail  or
through the social networks.

Gives  important  information  about  the  design.  Already
mentioned in this chapter, Page 7.
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Save File: Save the Design Document (DSG files).

Save as...: Save a copy of the working window with another
name.

Save Motif: Create a motif  (*.motif  file) out  of a design you
created. You can also use a block of sections instead of the
whole design. Use the motif from the Catalog (page 32).

Allows  you  to  print  your  design  in  a  standard  way  or  with
different styles. Already mentioned in this chapter, Page 19.

This option allows you to upload the design that is on the work
window to the Social Networks - Twitter. Already mentioned in
this chapter, page 9.

System options

System Settings gives a quick access to the Preferences a Setup window. The
other way is from File Page > Options group > Preferences and Setup 

The View ribbon
The View ribbon contains all the commands needed to control how your designs will be displayed
on screen. It gives access to the basic Zoom tools, visualization mode (Normal – 3D), lets you
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enable  /  disable  reference  tools  and  synchronized  windows  (Satellite,  Simulation  and  Stitch
Navigation), etc.

Zoom Tools

The Zoom group contains all the zoom and panning commands you will need to work comfortably
on screen. However,  some frequently used zoom tools are always  available below the ribbon
independently of which one is active (on top of the main work area) and, if available, through the
mouse wheel.

Zoom Area (F6)

This is a versatile tool with several functions. The basic one lets you
define  a rectangular  region  on  the workspace and magnify  it  to  the
largest possible size.  Just  select  the tool,  move the pointer  over the
workspace,  click  and  drag  diagonally  to  define  the  region  to  be
magnified. When you release the button, that area will be shown to the
largest possible size.

A second function within this tool is a dynamic zoom mode: Once the tool is selected, hold the
Shift key pressed (the pointer shape will change), move the pointer near the center of the design
detail you want to zoom and drag up and down. The design will be zoomed in and out, following
your mouse drag dynamically.

The third function is triggered with the Ctrl key: when you hold this key pressed, your drag will be
interpreted as a panning command. You can alternatively use the Shift and Ctrl keys to perform
one or other actions.

Even more, the Zoom Area button is a little special one: If you click near the arrow sign below the
label More, it unfolds a menu with several more zoom tools. We will mention them later in this
section.

Zoom Total (Ctrl+F6)

This tool considers all objects in your design and calculates the necessary zoom factor
to produce a view where all of them are shown in your screen.
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Pan

Pan is the action of  moving the viewable area so different regions of the design appear
on the screen. The result is similar to what you get when  using the scroll bars. Note
that the physical design position does not change at all, just the region you are viewing
changes.

To use the Pan command, you have two different ways:

a) Select it from the auxiliar toolbar, move the pointer over the workspace and drag.
The tool will not remain active when you release the mouse button;

b) From Reference Tools, click on Show Rulers. Now place the cursor over the ruler, it
will change from an arrow to a hand. Click and move the mouse. You will see that the
workspace and ruler move in the direction you move the mouse.

Zoom In – Zoom out

Zoom In (+) allows  a  more detailed (closer) view of the design, while Zoom Out (-)
produces a less detailed view, (more distant) 

Both  tools  work  with  a  predefined  factor  you  can  set  through  File  –  Options  -
Preferences Setup – Workspace – Zoom.

Zoom in-out using the mouse wheel

If your mouse has a center wheel, you can use it to zoom in and out. Just move the
pointer  to  the region  you  want  to  keep visible  and rotate the wheel  clockwise  or
counterclockwise. 

Zoom Scale

This control allows you to set the main view to a given predefined scale. Please, note
that you need to calibrate your screen to get accurate results.   See Calibrate Rulers,
later on, in this chapter.
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More Zoom options

As mentioned, more Zoom options are available when you unfold
the menu using the arrow in the main Zoom button:

- Zoom commands to several predefined scales.

- Zoom to selected objects

- Zoom to previous view

- Zoom to design limits

Draw Mode

Normal mode

The main view can display your designs in three modes: the standard or normal
mode, the 3D and the 3D + Aux.

The normal mode provides an schematics representation of the design, where
all  the elements (stitches,  entities contours,  etc)  are drawn with  lines of  the
same thickness.

You can switch the view mode using the controls in the group Draw Mode or using
the corresponding button on the Auxiliary toolbar, located above the workspace.
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3D mode

It  is  a  3D  piece  simulated  mode,  where  the  design  is
displayed in a very realistic representation, that provides a
good feedback about what its final appearance will be.

3D mode can be tuned to match your preferences and to
get the most realistic view possible. Click on the arrow  on
the  lower  right  corner  to  display  3D  Light  and  Quality
settings. 

A small box will display, with controls to set light direction
(drag the small  mark in the edge of  the shaded circle),
contrast and simulation quality (more quality means lower
display speed, but modern video hardware allows you to
work comfortably even at top quality).

3D + Aux. mode

It is the same as the 3D piece simulated mode, but it also shows the image used
as reference for designing. Shortcut for this function (F7).
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Reference tools

During the creation or edition processes, you may need some geometric
references to ensure the design fits a predefined size, or keeps an specified
layout. Also, you may need some tools to help you move along your design
without making too many clicks and wasting time. These are sets of graphic
elements that will help you with these tasks.

There are three Reference Tools:

Rulers: You enable two of them, one horizontal and the other vertical. You can display 
Metric or English units. They help you get an idea of the design's size.

Scroll Bars:  You enable two bars (horizontal and vertical) with a slider. Moving the  
slider will move all the work window in the direction you move the slider. It doesn´t  
modify the image at all.

AutoScroll: All around the main view, between the workspace itself and the
rulers, there is a region called auto scroll region. Just clicking on
that area will  trigger a pan action into a direction set according
with the edge clicked.

Moving  the  pointer  away  from  the  scroll  region  will  stop  the
panning. Panning speed and size of the auto scroll region may be
controlled  through  File  –  Options  –  Preference  Setup  –
Workspace – Auto scroll page.

Snap Modes

The snap tool restricts the placement of design object elements
to predefined points, such as, grid points, other objects singular
points,  etc.  The  snap  mode  is  useful  to  create  geometric
shaped objects or to perfectly connect objects. You can activate
the snap tool for creation and/or for edition.

The Snap to Grid and To SubGrid modes restrict elements placement to grid and sub-grid points
respectively. The Snap To Hot Points allows you to place elements exactly at the middle point,
center, border, etc of an existing object: just moving the pointer near a singular point will display
an  small  legend  and  the  mouse  pointer  will  be  trapped  by  the  singular  point  like  it  was
“magnetized”.  Observe the following picture:
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To  specify  what  hot-points
are enabled,  select,  To Hot
Points   and  then  click  on
Setup.

The Options and Preferences Snap page will be displayed and you can set what type of singular
points should be recognized.

Enable or  disable the different  modes (To Grid;  To Angle;  To Hot Points)  by clicking on the
desired button in the Snap group.   

The sub grid must be enabled from the Auxiliary bar, clickin on the Show Grid arrow, and then on 
Grid Settings.

To disable any of the snaps just click on the “Release” button.

Synchronized Windows

Simulation View

The simulation view is a floating window that displays a realistic simulation
of the design. Due it is separated from the main view, you can keep the
simulation view opened, displaying a region of the design while the main
view displays a different region.

Both views may work  synchronized,  so,  the simulation view reflects,  almost immediately,  the
changes made in the main view.

The simulation  view has  a  tiny toolbar  that  let  you  to  use  some zoom  tools,  set  simulation
preferences, adjust thread colors (allowing to use an special palette) and print the simulation.

All these commands are also available in the Simulation View context menu.
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Satellite View

This  floating  window provides,  all  the  time,  a  complete  view of  the
design and adds a graphical reference to give you feedback about the
region currently displayed in the workspace. The examples below show
the workspace with the Satellite opened in two different situations. Note
the small rectangle inside the Satellite view, indicating the region of the
design currently displayed in the workspace.

Satellite view is synchronized with the Main view: if you change the zoom level or pan the Main
view, Satellite will  be refreshed properly.  You can also pan and zoom from the Satellite view:
dragging the rectangle (start drag from its interior) will produce a pan action in the Main view and,
dragging the rectangle edges, will produce a zoom action in the Main view.
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Miscellaneous

This  button  allows  you to  set  the options  for  visualizing  how a design  in
continuous working mode would be like without the need to take it  to the
machine to test it.

Click on the arrow button to unfold the options menu.

Enables/disables  the  visualization  of  the  continuous  drawing  of  the
design.

Allows  you  to  configure  the  horizontal  and  vertical  spacing  of  the
objects.

Move the slider to modify the transparency of all the objects except for
the original one. 

You can make a visual repetition ot your design on both horizontal and vertical axis.

The idea of this tool is to give a very real result of how your design is going to be, with no need of
taking it to the machine to test it and adjust parameters.

You can set up the distance between designs for both axis.

Modify the parameters until you are satisfied with the results. Remember to write down the values
used for that particular design.
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Measure Tool

In the  View ribbon >  Measure  group, you will  find a tool  to measure objects on
screen. Just click on the button to activate the tool, move the pointer to one end of
the  object  to  be  measured  and  drag  towards  the  other  end.  An  on-screen
transparent label will follow your mouse movements, showing distance measured,
angle and horizontal and vertical coordinates. To exit the tool, press the Esc key.

If  Show Rulers is enabled, you can quickly call  this tool  by picking it  up from the menu that
appears when you click  the small box with the measurement units legend, located at the upper
left corner of the workspace (where both rulers cross – See Screen Calibration).

Screen Calibration

Some zoom tools are related with a scale, like zoom 100% (or 1:1). So, when you use this kind of
tools, the objects in your screen should have true size, that is, if you measure them with a real
ruler placed over the screen, it should measure the same the system indicates.

To accurately do this, its is required to calibrate your screen. You will need a real ruler (a soft one,
made of plastic is better). Follow this procedure:

1- Click the icon located at  the upper  left  corner of  the workspace, the one with  the
measurement units legend in it, and select Ruler Calibration from the menu.

2- Put a real ruler over the screen, below the system horizontal ruler and aligned with it.

3- Click the arrow button to get a match between the marks in real ruler and the marks in
the system ruler. Then click the green button. Your monitor will be calibrated.
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Auxiliary Toolbar

Below the ribbon bar and on top of the workspace you will find this bar, where you have some
useful functions handy like Create Sections; Select Objects;  Smart  Design; Zoom tools; and
some visual aids like guidelines, grid and subgrid; object guides and hide/show commands (first
figure). On the right side of this bar there are some “traffic lights” to show/hide/block different
object layers (Auxiliar; Screen Printing; Cutter; Hotfix) (second figure).

Create Sections

This button gathers all the tools that are available for creating a hotfix design
(depending on your system level). Click on the arrow to unfold the list of tools.
The creation tools are explained in Chapter 4.

Select Object

This tool allows you to select an object or block of objects, which can be raster
images, vectors, or hotfix objects. Then you can make modifications on the
geometry (expand, reduce, rotate, mirror, etc.). 

A large set of selection tools is available from the Select Object menu, to be
able to  create your blocks. 

Smart Design

This working mode accelerates the activities related with the objects creation
and  edition,  as  well  as  some  functions  related  with  auto-digitizing  (auto-
complete).

The  Smart  Design  tool  includes  the  different  types  of  objects  with  their
respective fill modes. It will be explained in Chapter 7.

Other visualization tools.
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These were explained in Zoom Tools, page 31 in this chapter.

Grid

The Grid command controls the visibility of a set of small, equally spaced marks on
the workspace.  These marks allows you  to  accurately place objects  within  your
design.  You  can control  many aspects  of  the  grid,  such  as  the  distance,  mark
shape, color, etc. Use the Grid button to turn on/off grid visibility.

Grid setup
Grid customization controls are displayed when you click on the arrow
button. Show grid lets you hide/show the grid. A basic and interactive
size setting is available with the command Setup Grid and a detailed
configuration is accomplished through the Grid Settings...

Setup Grid: Turn on the grid and then select Setup Grid. The mouse pointer will change
into a ruler shaped one, and when you drag, the grid size will  change following your
mouse  movements.  This  method  is  useful  when  you  need  to  set  the  grid  distance
matching the size of an object displayed in the screen, such as a detail in an image.

Grid Settings...:  This command pops up the  Options  box, with the grid page selected.
You will find controls to set the grid position (grid displayed above or below the objects),
style, color and size. You can also set a sub-grid, allowing a set of closer sub-marks be
displayed inside the main grid marks.

Guidelines

We call Guidelines to a set of auxiliary vertical and/or horizontal lines you can set to
help with object alignment and placement.

To add a Guideline, use the following procedure:
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1) Move the mouse pointer over
one  of  the  rulers  (vertical  or
horizontal)

2) While  keeping  the  Ctrl  key
depressed,  press  the  mouse
left  button  and  drag  towards
the workspace. A guideline will
appear and follow the mouse
pointer while you drag.

3) Once the pointer reaches the
position you want, release the mouse button. 

Repeat the operation for each guideline you want to add.

If you need to change a guideline position, just move the pointer over the
corresponding icon located over the ruler, and drag it. 

Using the mouse right button over the guideline icon, opens a
context menu with a group of commands. You may remove one
or  all guidelines,  set  a  guideline  as  default  and  change the
guidelines color.

Guide setup

Guide  customization  controls  are  displayed  when  you  click  on  the
arrow button. Show guide objects lets you hide/show the guidelines.

Using the  Guide Setup –  Delete All  Guide Objects,  you can  quickly
remove all the guidelines.

Having the  Guidelines  enabled, the command  Guide  Setup – Guide
objects Options... pops up the Guidelines Editor window.
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From this window,  you can achieve a precise location of the guidelines you
made. To modify a guideline, just click on it to select it, change the coordinate
and press Apply. 

Also you can add new guidelines from the Add button.  Select  the type you
want,  insert  the  coordinates,  choose  a  color  and  press  Apply.  The  new
guideline will appear on the screen.

Apart from the common ones, Horizontal  and Vertical lines, you will  find three new kind of
guides: Free Line, where you can make a segment guideline with the direction you want; and
two guide objects, Square/Rectangle and Circle/Ellipse in which you can have a shape made
out of segment guidelines.

To delete a guideline, click on it to select it, and click on Delete. 

You can also save your current guideline disposition as a template for a later use.

Show/Hide design references

We call  Design References to a set of  graphic elements that improve design
visualization.  This  set  contains  the  controls  required  to  turn  on/off  these
elements.

Solid Vector : Shows the solid (complete) vector or just the outline of it.

Show Sections: Show/Hide entities wireframe. Sometimes, specially during the finishing
tasks, is usefull to view just the stitches, hiding all other references.

Show Connectors: Show/Hide thread connections between entities.
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Show Commands:  Show/Hide  graphic  indicators  for  machine  functions  or  machine
controls such as, color change, thread trims, etc.

Show Design Start/End:  Show/Hide special screen symbols to indicate designs start
and end points.

Show Hotfix: Turn on/off beads display in realistic 3D view.

Show Solid Hotfix: Turn on/off beads display in plain colors.

Traffic Lights

These coloured led buttons allow you to show, hide, or block different object layers (Auxiliar;
Screen Printing; Cutter; Hotfix).

Auxiliar

Allows control over Images used as reference for design creation.

Click on the Auxiliar  button to toggle between Hide and Show image.
When image is shown, led will be green; when image is hidden, led will
be red.

Click on the arrow to visualize the other available options:

Turns off  all  reference images. To turn them on,  just  click  over  the
auxiliar button again. Light will change from red to green.

Locks all reference images. This means that you cannot select them.
Very useful when you are digitizing and do not want to move the image
or  select  it  by  mistake.  To  unlock  them,  just  click  over  the  auxiliar
button again. Light will change from yellow to green.

If  you have vector images,  and/or hotfix objects on screen and you
want to leave only the auxiliar images visible. Auxiliar led will be green
and all the others will be red.

If  you have vector images,  and/or hotfix objects on screen and you
want  to  lock  them,  to  be  able to  work  on  the  auxiliar  images only.
Auxiliar led will be green and all the others will be yellow.

When you enable the onscreen simulation (3D), the Auxiliary images will become hidden. To view
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the auxiliary images again, just disable the simulation view.

If you open the Object Manager to see the Document Map, the changes on the traffic lights will be
reflected  on  it.  Locked  objects  will  appear  grayed.  Hidden  objects  will  not  appear  on  their
respective tab.

Screen Printing

Allows control over Images that are part of the final design, for example
as background of the embroidery.

When you set an image as screenprinting, it will be showed, along with 
your embroidery objects, in the simulation window.

Click on the Screen Printing button to toggle between Hide and Show
image. When image is shown, led will be green; when image is hidden,
led will be red.

Click on the arrow to visualize the other available options:

Turns off all screenprinting images. To turn them on, just click over the
screenprinting button again. Light will change from red to green.

Locks all  screenprinting images.  This  means that  you  cannot  select
them. Very useful when you are digitizing and do not want to move the
image  or  select  it  by  mistake.  To  unlock  them,  just  click  over  the
screenprinting button again. Light will change from yellow to green.

If  you have vector images,  and/or hotfix objects on screen and you
want to leave only the screenprinting images visible. Screenprinting led
will be green and all the others will be red.

If  you have vector images,  and/or hotfix objects on screen and you
want  to lock them, to be able to work on the  screenprinting images
only. Screenprinting led will be green and all the others will be yellow.

When you enable the onscreen simulation (3D), the Auxiliary images will be visible.

If you open the Object Manager to see the Document Map, the changes on the traffic lights will be
reflected  on  it.  Locked  objects  will  appear  grayed.  Hidden  objects  will  not  appear  on  their
respective tab.

Cutter

These figures are the ones that will be sent to the cutter device.

Click on the  Cutter  button to toggle between  Hide and  Show image.
When image is shown, led will be green; when image is hidden, led will
be red.

Click on the arrow to visualize the other available options:

Turns off all  Cutter images. To turn them on, just click over the Cutter
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button again. Light will change from red to green.

Locks all Cutter  images. This means that you cannot select them. Very
useful when you are digitizing and do not want to move the image or
select it by mistake. To unlock them, just click over the  Cutter button
again. Light will change from yellow to green.

If  you have vector images,  and/or hotfix objects on screen and you
want to leave only the  Cutter images visible.  Cutter led will  be  green
and all the others will be red.

If  you have vector images,  and/or hotfix objects on screen and you
want to lock them, to be able to work on the Cutter images only. Cutter
led will be green and all the others will be yellow.

When you enable the onscreen simulation (3D), the Cutter images will be visible.

If you open the Object Manager to see the Document Map, the changes on the traffic lights will be
reflected  on  it.  Locked  objects  will  appear  grayed.  Hidden  objects  will  not  appear  on  their
respective tab.

Hotfix

Allows control over the hotfix design objects.

Click  on  the  Hotfix  button to  toggle  between  Hide and  Show
embroidery.  When  Hotfix is shown,  led will  be  green;  when  Hotfix is
hidden, led will be red.

Click on the arrow to visualize the other available options:

Turns off all  Hotfix objects. To turn them on, just click over the  Hotfix
button again. Light will change from red to green.

Locks all Hotfix objects. This means that you cannot select them. Very
useful when you are working on an image or hotfix object and do not
want to move a  Hotfix object or select it by mistake. To unlock them,
just click over the Hotfix button again. Light will change from yellow to
green.

If you have raster and vector images, and/or hotfix objects on screen
and you want to leave only the Hotfix objects visible. Hotfix led will be
green and all the others will be red.

If you have raster and vector images, and/or hotfix objects on screen
and you want to lock them, to be able to work on the  Hotfix objects
only. Hotfix led will be green and all the others will be yellow.

If you open the Object Manager to see the Document Map, the changes on the traffic lights will be
reflected  on  it.  Locked  objects  will  appear  grayed.  Hidden  objects  will  not  appear  on  their
respective tab.
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Hotfix pieces library
The vertical toolbar that  appears at the left  of the working area displays a collection of  hotfix
beads you can easily pick to create your  hotfix objects.  This collection,  that  also appears as
galleries within the hotfix objects ribbon, and that is quite similar to a color palette, is called Hot fix
Palette or Bead Bar.  

Hotfix Palette or Bead Bar.

To choose what hotfix pieces you’ll see in the bead bar, you need to use a large set of hotfix
pieces called Hotfix Catalog. Using the catalog you can define and change the bead bar, create
new ones and save and open them from disk. So, the Hotfix Catalog is also the management tool
for bead bars.

Clicking the  Hotfix  Catalog button in  the vertical  toolbar  opens the catalog window.
Inside it, there are two main panels: the bead bar at the left and the library at the right

The main idea behind this box is that you build your bead palette, or bead bar by selecting the
pieces you want to use from the beads library. The following paragraphs explain how to do that
and also describe the panels and related tools in depth.

Beads Library

The Beads Library is a collection of thousands of hotfix pieces organized by type that you can
easily browse to choose the pieces you’ll use in your design.

There are a group of tabs located at the top of the right panel to let you access the catalog by
bead type: rhinestones, rhinestuds, nailheads, etc. 

Just activate the tab corresponding to the type you want to browse and then click on one of the
listed shapes. The available Sizes and pieces will be shown underneath. Use the Controls to add
the desired beads to your bead bar. They are explained next.
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Available Controls:

Between the two main panels you will find several icons: a yellow star, and some colored pointing
arrows. Each one has a different purpose.

Star icon: Stepping on a piece, and clicking on this icon will place a little yellow star on the
upper left margin of the selected bead and will add it to the Favorites tab. You can have all
you most used beads on the favorites tab for a quicker selection. Click over the star icon to
unmark the piece and delete it from the favorites tab.

Add / Replace / Remove from bead bar: A group of arrow icons allow you easily add, replace
and remove pieces from the bead bar.

When you step on a piece on the right panel, if  a green left pointing arrow appears,  it
means that it is not currently included in the bead bar (on the left panel) and you can simply
click on the arrow to add it. Instead, if a red right pointing arrow appears, it means that it is
already included in the bead bar and clicking on the arrow will remove it from the bead bar.
You can also double click on a bead to remove it from the bead bar. To replace an existing
bead by the one you want,  highlight  a bed on the bead bar, and press the orange left
pointing arrow icon.

Bead bar
This panel is just a more detailed view of the bead palette displayed at the left of the working
area.  It’s  an  ordered  list  of  hotfix  pieces,  you  can  freely  arrange  by reordering,  adding  and
removing elements. The list must have at least one element and may have as many elements as
you need.

Changing order: To arrange the order of the pieces, just click on one and use the up and down
arrows until you locate it in the desired position. You can also use the context menu to move a
piece up or down into the list, one position at a time.

Removing pieces: Step on the item you want to remove to highlight it and click on the red right
pointing arrow, or double click on it.

Adding pieces: Simply, pick the piece you want to add from the library, drag it into the list and
drop  it  at  the  desired  position.  You’ll  see  blue  horizontal  marks  appearing  and disappearing
between the items; they are indicating the position the piece will take if you drop it in that moment.

Be careful when you drop because dropping between items will  add pieces while dropping over
an item will replace the piece.

Replacing pieces: If you need to replace a piece for a different one you may proceed to remove
it and then to add the new one or you may take a shortcut: pick the new piece from the library,
drag it into the list and drop it over the piece you want to replace.

Clearing the bead bar: By default, the system shows a predefined bead bar to let you start
working. However, you may want to create an entire new one, starting from zero.

This tool, located at the bottom left side of the catalog window, clears the entire bead bar,
producing an empty, fresh list.
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Save the bead bar: Once you create your own bead bar, or modify an existing one, you can
save it to disk for permanent storage.

To do it, click the Save command and in the save dialog box, enter a name for your bead bar
and click OK.

Load a bead bar from disk:  Previously saved bead bars may be loaded using the Open
command. When you activate the command, the system displays a list with the names of all
previously saved bead bars. Just select the one you want to load and click OK.

Deleting a bead bar from disk: Use this command to permanently delete saved bead bars.
Just activate the command, select the bead bar you want to delete from the displayed list
and click OK.

Set as Default: The current bead bar may, that is, the one currently displayed in the left
panel, may be set as the default bead bar. This means that every time you create a new
design, that bead bar will be automatically loaded and displayed in the vertical toolbar.

Quick Hotfix Selection tool

Click on the arrow to the right of the Bead Bar icon to open
the Quick Hotfix selection tool. It contains useful commands
to quickly manage your bead bar.

Open Hotfix catalog: to let you configure your bead bar.

If you replace any of the beads, all objects that were using the replaced bead will be recalculated
with the new bead.

Delete unused beads: Checks used beads in your design and deletes the unused ones from the
bead bar.

Add bead: Lets you select a bead that will be added to the current bead bar. It opens the Hotfix
Selector window.

 2 - 49



Hotfix Era – User's Manual

The box allows a quick bead selection based on Type, Size, Color and Shape.

The best way to use it is to follow this sequence:

1- Select a bead type (the left panel shows all the bead types available in the system bead library)

2- Once a type is selected, the right panels are updated to display the available sizes and colors
for that type. Use the upper right panel and select a size.

3- Once you select a size, the right lower panel is updated to show all the bead colors available
for that type and size. Click on the desired one and press Add.

Bead Gallery

The Bead Gallery is  a  graphic  control  that  appears  within  all  hotfix  fill  ribbons.  It
displays the bead types you have in your palette. By default, the beads are sorted by
color  and  size  but  you  may  set   the  system  to  use  palette  order  (Options  and
Preferences - Project - Hotfix - Hotfix Gallery sort by)

Bead bar behavior for existing and new designs

HotFix ERA maintains bead bars in a per-design basis. That is, every time you save a design, the
hotfix pieces palette is packed and saved inside it. So, when you open a previously saved design,
no matter what you current bead bar is, the bead bar you was using when you saved the design is
automatically loaded.
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HotFix ERA allows you to open a previously saved bead bar at any time. In this case, the current
bead bar is replaced by the loaded one, keeping the bead’s order: piece #1 of the old bar is
replaced by piece #1 of the new one, old #2 by new #2 and so on.

When you create a new design, the system loads the default bead bar. You can set what bead
bar should be used as the default one, using the Set as default command (Def button), inside the
hotfix catalog window.

You will be able to enter the information that corresponds to the manufacturer (and its logotype),
line, material, length and size, color code, pantone, color, etc., while you can choose the shade
from a color table or by entering the RBS or HLS values.

From the Edit  button (second button) you will be able to edit any thread lines you have already
loaded into the system. A table with  show the values  you  defined for each of the colors  when
creating the  chart.  To  modify a value, double-click on the corresponding box and change the
value.

From the Delete button (third button) you will be able to erase any of the thread lines you have
already loaded into the system.

Background color and fabric

The option Background is available above the Palette bar besides
the Working Area. This command will let you define the color that
will be displayed as background of the design. 

Color Background

To set a background color, simply click on the color table. You can also use the RGB or the HSL
definitions.  Observe the result obtained in the Sample box. Finally,  click on the OK button  to
confirm.

Selecting a fabric as background

Click on Edit  Background Fabric to access the window from
which you can select a  background fabric  from the available
ones. It  simulates  the  fabric  on  which  the  design  will  be
embroidered, and its purpose is to assist the design visually,
since it does not modify the stitches. 

Once you have selected a background fabric, click on the OK
button to select it.

The new background will be visualized  when you execute the
Simulation View  (Ctrl+F7), or the On-screen Simulation View
(F7).
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Working with Raster Images
With  Hotfix Era you can open a bitmap image of  multiple formats and convert  it  into a hotfix
design. With the image applied in the work area, you will be able to use it as reference guide and
build  up  the  necessary  beads.  In  a  quicker  way  you  will  be  able  to  apply  an  automatic
transformation from image to hotfix. 

Note: You may insert an image before or after having started working on a design in Hot Fix Era this option will allow you to 
add new sections to designs that have already been started.

Supported image formats

The following formats are compatible with Hotfix Era

 BMP – Windows Bitmap

 JPG – JPEG Bitmaps

 PCX  - Paintbrush

 TGA - Targa Bitmap

 CLP - Clipboard Format

 PNG – Portable Network Graphics

The working sequence with images is the following:

1) Acquire the image from the artwork by means of a scanner or use a graph created in
any related application.

2) Scale the image to the final size.

3) Capture the design sections from the image outlines.

4) Save the design along with the reference image if necessary.

Below you will find details on each of these steps.

The Artwork ribbon contains all Hot Fix Era available commands to work with raster and vector
images.
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Open image

A way of inserting background images is to use those created using a graphics program, taken
from a clip-art, or downloaded from the Internet.

HotFix  Era allows  you  to  load  images
through  the  button  “Open  Image”  on  the
“Artwork” ribbon, “Raster” group. 

You can also use the “Catalog” button on the
“Home” ribbon, “Insert” group. On the Media
tab, select Images-Raster. 

Note: The location of the preloaded Raster images is: 
C:\Users\Public\Pictures\Sierra Technology\Artwork Bitmap

The Open Image window appears. You may
have two folders: Raster and Vector. Double
click  on  Raster  to  view the  folder  contents.
You  have  some  preloaded  bmp.  files.  to
choose from. Select any and press the Open
button to take it to the working area.

To load any image:

In the lower part of the window the box “Files
of type” allows you to select the image format.

1) Select drive and folder on the left side.

2) On the right side, click on the image.

3) Click on Open.

When inserting the image, the Image ribbon appears so that you can work over it.

Deleting an image

If you want to delete an image from the active document, simply select the image from the select
object mode and press the “Del” key (Delete) .
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Capture Image from Scanner

From  the  Artwork  ribbon  click  on  the  button
“Capture”  and  then  on  “Scanner  Capture”  to
open  the  corresponding  scanner  dialog  box.
Complete  the  information  required  (mainly
resolution and color mode).  Though the way of
working  depends  of  the  scanner  you  have
installed, the normal process follows these steps:

1) Pre-scan to preview position and center image.

2) Select the area to be scanned.

    3) Capture the selected area.

Once the scan is complete, the image will appear on the Hotfix Era's active document. Remember
the following parameters; they are very important when obtaining an image from a scanner:

Resolution:

It is normally measured in dpi (dots per inch or points per inch) and it defines the brightness of the
digitized image. The higher the number, the neater the image, but it will also use more system’s
memory. Except on 5x5 cm. or smaller images, a 300-dpi resolution is correct. 

Color Mode:

You can capture an image in color or black and white. If you capture it in color, you must indicate
the number of colors to be used. On most cases, a 256-colors mode is enough; if you use more
color, the resulting image will be better viewed but will take more memory. If you wish to capture
the  image  in  black  and  white,  you  can  use  256  shades  of  gray.  Have  the  following
recommendations in mind when scanning images: 

 Only scan the area of the image that you will work on. This will result in smaller, 
manageable images.

 Use low resolution settings. On most cases, a 300-dpi resolution is enough. If you
are going to work with the Photo type, the image used must have a high contrast 
level. 
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Configuring the scanner

The scanner is a device that reads the images printed on paper or
fabric.  HotFix Era works directly with any Twain-compatible scanner
already installed on your Windows system.

Note: Most scanners come with Twain-interface software. Refer to your scanner manuals to obtain further information on the 
controllers and how to install them. Once a scanner has been configured, you will not need to repeat this process.

Since you may have more than one Twain device installed on your system (for example a scanner
and a desktop digital camera), it will  be necessary to indicate  HotFix Era  which device to use.
Proceed as follows:

1) Click on Capture > Scanner Setup...

2) A Select Source dialog box opens, showing all the available Twain sources. 

3) Click on the source that corresponds to the device to be used and press Select.

You  may  also  insert  a  raster  image  using  the  Windows
clipboard. Using your favorite application, select the image and
press Ctrl+C. 

This action copies the image to the Windows clipboard. Then,
activate  Embroidery  Office  and  on  the  HOME  ribbon,
CLIPBOARD  group,  click  on  “Paste”  and  then  on  “Paste
Bitmap”. 

The image will be inserted centered at the origin point (0,0).

Any time a raster image is selected, the Image ribbon is automatically displayed
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Cropping Image

Click  the  button  Crop  Image  and  the  cursor  will
change, indicating that it is suitable for cutting.

Draw a rectangle over the area of the image that you
want to preserve and all the part inside the rectangle
will  be  preserved,  the  part  in  the  outside  will  be
deleted.

Modifying Image Colors

Clicking on the button, opens a window, in which you
can  quickly  reduce  the  number  of  colors of  the
image.  The  window  is  divided  in  two  panes,  one
shows the original and the other the results. It also
has zoom tools and pan for your convenience. When
you are satisfied with the result press OK to take it
back to the main working window.

Scale, rotate and move images manually

Click on Select Object (press F11) and click on the image you want to
select. The image will become surrounded by a box with highlighted 
corners and centers.

You can work with the corners and centers to expand, compress, 
move and rotate the image freely.

You can also use the commands to scale and align for a precise 
adjustment.

Note: Perform the necessary modifications on the image before starting to create the design. If you have already created
sections and you change the size, move or rotate the image, it will be difficult to modify the sections so as to adjust them to
modified reference image.

Click on the image and drag any of its corner nodes to adjust its size proportionally.

When dragging a determined corner node, the scaling 
will leave the opposite corner fixed in its position (right 
figure). 

If you drag while pressing the Shift key, the scaling will
be performed keeping the center  of  the image in its
position,  while  all  the  corners  scale  following  the
movement of the mouse.
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But, if you drag the pivot of any of the mid-sides, you
can change only one of the dimensions (horizontal or
vertical depending on the dragged side), as shown in
the right figure. If you hold down the Shift key while
dragging, you will  be able to move both vertical and
horizontal sides in a symmetric way.

Taking the mouse pointer next to the central zone, changes the cursors shape.

To rotate the image, while holding down the Ctrl key, click and
drag  any  corner  node.  Observe  how  the  image  border  is
modified as well as the mouse pointer (right figure). 

To finish this operation, simply release the mouse button.

Scale image & Shape

Once you have the image on the screen, whether it was in the disk or
scanned,  you  can  perform  certain  operations  such  as  expand  /
compress, slant or rotate the image. Such modifications can be done
manually  or  controlled  from  the  Image-Layout  ribbon,  changing  the
values of the boxes Size (Width, Height) and Position. If  you want  to
modify the size in the same proportion, you must activate the padlock
icon as you can see on the example box of Size & Position.

Set Size (scale Tool)

This option allows you to precisely adjust the size of
a  reference  image,  altering  its  original  size
according  to  the  correct  measure  of  the  image
segment.  This  allows  you  to  work  with  an image
with  the  same  dimensions  that  the  final  design
should have.
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The working method is the following:

1) Click on the Set Size icon. Click on any point of the image and drag it. HotFix Era will trace a
line from the point to the mouse’s position.

2) Release the mouse buttons. The Image Scaling window displays the length of the traced line
and allows you to define the new value. Type in the corresponding size.

3) Clicking on OK, the image will be scaled so that the traced line has the indicated new size.

For example, if your design has to have
a  maximum  height  of  50  mm.,  after
inserting an image select the  Measure
and Scale tool, click on the upper part of
the image (shown in figure as point  1),
drag downwards up to the silhouette end
and release the button in point 2, so that
the Scale image box will  open showing
the length between points 1 and 2, while
it  allows  you  to  indicate  the  new
dimension that that distance has to have.

For this example, type 50 in the box placed at the right of the Height row, and press OK, all the
image is scaled so that  the segment 1-2 measures 50 mm. You can also use the Width and
Height controls to give an exact size to the entire image.

Set Angle (Rotate Images)

Fixing the rotation angle is useful for some Works where you need
precision. Look at the next sample:  We want the image to show the
hand totally vertical and not as in the original image.

1) Click in Fix Angle and draw a line as indicated in the figure

2) Releasing the mouse button appears a dialog box to set the
new angle of the line drawn. Set the value “0”
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3) When pressing OK, the image will be rotated so that the line
drawn is horizontal, which means the hand is totally vertical.

Mirror/Rotate

The application gives you the possibility to rotate an image to
specific  angles  (90,  180  and  270  degrees)  and  to  mirror
horizontally and vertically in the working window. 

Click on the button Mirror/Rotate to get the available options.

Properties

Saturation, Brightness and Contrast

This  type  of  edition  is  the  same as  with  any
basic  image editor.  Moving  the slider  of  each
control to modify the Artwork.

Transparency

From  the  box  Properties  you  can  modify  the
level of visualization of the image you have in
the working area. The lower the percentage of
transparency to  dimmer the image will  be.  At
the lowest value the image will dissappear.

Image Modes: Linked and Embedded

HotFix Era stores, inside the design file, information about the images you loaded, so they can be
displayed the next time you open the design. By default, the images are “Linked”, that is, instead
of storing the image itself into the design, only the location within your disk is stored. This is good
to keep design files small but, if you move the design to another computer, the link fails. For those
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cases, you may “Embed” the image, that is, instruct HotFix Era to store the image, not the link,
inside the design file.

Linking Images

HotFix Era will save a link to the image, so the next time you open the design the
image will load with the same position, size and rotation angle. It is required that
the image be kept on the disk with the same name and in the same folder where
it was when it was added to the design. This is the default behavior.

Embed an image

With the image selected, just click the button Embedded. HotFix Era will store
the image within the design file.

Images  are  automatically  switched  to  embedded when  you  modify  them,  for
example when cropping or reduce its colors. This is also the default mode for
images pasted from clipboard.

Using Raster images as...

Reference images

Usually, images are loaded to be used as reference for design creation. They
will become hidden when you activate the simulation window.

Open  the  Object  Manager  to  see  the  Document  Map,  which  consists  of
several tabs. If a raster image is used as Reference, it should only appear in
the Auxiliary tab.

Screen Printing images

On  some  cases  the  image  is  part  of  the  final  design,  for  example  as
backgroung of the embroidery. In this case, set the image as screenprinting,
so it will  be showed, along with your embroidery objects, in the simulation
window.

Open  the  Object  Manager  to  see  the  Document  Map,  which  consists  of
several  tabs.  If  a raster image is used for Screen Printing,  it  should only
appear in this tab.

All images no matter what kind they are will appear in the ALL tab.
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Save

If  you  are  planning  to  work  with  an  image taken from the  scanner  in  several
sessions, you must save the image on your disk, so that it will be available the next
time you open the design.

Save the file under EMF format, compatible with many programs that use vector
graphics, DXF and PLT. Depending upon the format selected, the border and body
or just the border will be saved.

To save an image:

1) Select the image.

2) Click on Save As, on the Artwork Image ribbon, Save group.

3) In the Save box, choose folder, name and format with which you want to save
the image and press Save.

It is recommended to use the default Image folder to save the images, even to save the new
graphic files that you copy or produce.

Vectorize. Image to figure

HotFix Era includes a complete vectorizer in order to transform a bitmap image
inserted in the working area in vector figures. Remember that you will be able to
quickly create the sections of a design from each of these vector images.

To work  on  a bitmap image select  it  and  activate the  command  Convert  to
Vector, from the Image ribbon > Convert group.
The Vectorizer box then appears. In it you will find a series of controls on the
Vectorizer ribbon, while the rest of the box will show a preview.

 

Observe at the top of the Previews there are three tabs, each of them allows you to visualize the
three stages by which a vectorized image should go through: the original figure, the clean figure
and, finally, the vectorized result.
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To make a zoom of the sample set out
in  the  preview  (in  any  of  the  tabs)
using the command window available
in its lower left corner: you can make a
specific zoom, zoom in whole or pan. 

Basically, you can follow two steps in order to vectorize the image. These are explained next:

Step 1 - Clean the image

This first stage implies reducing the complexity and noise of the graph, for the result to be as
clean and clear as possible. Since HotFix Era vectorizes the image scanning its changes in tone,
this first task is important in order to obtain good results. Have in mind that the cleaner and clearer
the image, HotFix Era will better interpret its shapes.

From the first sliding controls of  the Vectorizer you
can optimize the image, trying to leave it as clean as
possible, clearly defining its shapes and borders and
getting  out  the  colors  mix  that  “dirty”  the  result,
causing the so called impure images.

These controls are the following:

 Reduction: Moving the slider to the right you reduce the number of colors in the
image,  this  is  the  first  filter  you  should  control,  reducing  the  colors  without
deforming the image.

 Holes: This control eliminates the noise in the image, this noise is composed by
small pixels dissociate color, called “holes”. As you move the slider towards the
right, the application will eliminate the biggest holes.
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After  configuring  the  controls,
click on the Filter button for the
application to show you the result
in the Clean tab of the Preview.

In the figure observe the Preview box after Filtering the image, see that the Cleaned tab is activated

According  to  the result  obtained,  modify  the values of  the
controls previously mentioned, until the product look like what
you expect. Do this as many times as necessary. 

After cleaning the image and having obtained the convenient
result,  use  the  two  following  controls.  Their  function  is
explained below:

• Final Colors: From the colors view select those tones that are similar, and click on the
Combine button for them to merge. It is convenient to reduce the number of colors of the
image when possible, in this way the application will  be able to distinguish easily the
changes in tone, thus obtaining more precise vectorization. To select two or more colors,
press Ctrl and click on the color to merge, then press the Combine button.

• Transparent Color:  HotFix Era scans the image and captures the background color of
the  image  so  as  not  to  include  it  in  the  vectorization  since,  when  vectorizing  the
background color of the image it will form a figure that will “frame” the result. observe the
image on the right; it is a bitmap inserted as image in HotFix Era which background is
gray. 

Now, as an example, the following image will be vectorized changing its transparency color. 
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In  the  following
examples,  figure  (a)  is
the  result  of  vectorizing
the  image  defining  the
gray  color  as
transparent.

When  converting  into
stitches,  you  will  obtain
the  result  shown  in  (b).
Note  that  the  design
does  not  reproduce  the
gray box that frames the
original representation.

On the other hand, figure
(c)  shows  the  result  of
vectorizing  the  image
used as model specifying
that  the  white  color
should be transparent. In
this  case,  when
converting  all  the
vectorial  figures  in
stitches  sections,  the
result  will  be  the  one
shown in (d).

Note: You should apply one or other method depending on the result you want to achieve.

Step 2 - Vectorize

Here you should transform the image (free from noise) in vector shapes.

Once you have created the vector-based figures, you will be able to work on them freely: you will
be able  to  scale them, modify their  shape changing  the nodes,  change their  color,  etc.  The
creative possibilities, when the original bitmap image is vector-based, are many. It all depends on
your imagination.

For  this  to  happen  you  must  configure  well  the
items that define the characteristics of the created
vector (right figure). These are described below:

Max Error:  This control  defines the curvature degree that  the trace will  have. It  increases or
reduces the precision the vector curve will have regarding to the original bitmap.
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Sharpness: If you increase this value, the number of nodes that the created vector-based figure
has will decrease, thus obtaining a sharpened result.

These two controls define the curvature degree that the vector will have. High values of these
controls results in rounded outlines. If  these items have small values, the trace of the vector-
based figures will adjust to the outlines of the bitmap image.

Min. Area: It eliminates the small surfaces, according to the value specified in the sliding control.
It is useful to exclude the smaller elements from the vectorization.

Observe the result that the chosen values will produce when vectorizing the bitmap image from
the Vector tab in the Preview frame.

If you click on the OK button you will  confirm the values entered to create the vector Figures.
These will reproduce the shape presented in the Vector tab of the Preview.

Upon accepting, the vector figures will appear in the work area.

Finally, you must create sections as from these vector figures, choosing carefully the type and fill
they will have (See Chapter 4 Creating Hotfix Designs). 

You must define the orientation
of  the  direction  lines,  the
location  of  the  entry  and  exit
points,  the correct  sequence of
sections,  etc.  according  to  the
figures that form the design.
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Working with Vectors
HotFix  Era allows  you to  work  with  vector-based images;  these are  a new method to  easily
digitize shapes of all types, also having the opportunity to combine two or more figures so as to
obtain complex structures.

Once you obtain the desired figure,  you will be able to convert it into a section (Auto-Digitizing)
thus simplifying the creation process.

If  these vector-based figures are not deleted before saving the document, they will  be saved
together with the design. This will  be useful if  you want to modify the created shapes in next
editions.

Vector-based  graph:  Contrary  to  the  bitmap  graphs  (or  BMP)  the  vector-based  figures  are
created as group of lines and not as individual points or pixels patterns.

Supported vector formats

The following formats are compatible with HotFix Era: 

 WMF - Windows MetaFiles

 EMF - Enhanced MetaFiles

 CDR  – Corel Draw

 CMX  - Corel Presentation Exchange

 AI  - Adobe Ilustrator

 Imaging - EO Imaging

 DXF - Drawing Exchange Format

 PLT - Vector Plotter Files

Note: To use the cdr and cmx formats you need Corel Draw ® installed in your system and the file opened in the application. 
To use the ai format  Adobe Illustrator ® installed in your system and the file opened in the application.

All available methods to insert a vector artwork are available within the Artwork ribbon bar
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Open a Vector File

A way of inserting background vectors is to use
those created using a graphics program, taken
from a clip-art, or downloaded from the Internet.
Hotfix ERA allows you to load vectors from disk
through  the  button  Open  Vector  File  on  the
Artwork ribbon > Vector group.

The Open window appears, showing the images available on disk in different formats. In the lower
part of the window the box Files of type allows you to select the image format. 

To load an image:

1) Select drive and folder on the left side.

2) On the right side, click on the image.

3) Click on Open

If you want to delete a vector from the active document, simply select the image from the select object mode and press the 
Delete key.

Get Vector from CorelDraw and Illustrator

HotFix  Era is  compatible  with  Corel  Draw
versions 10, 11, 12, X3, X4, X5, X6 and X7 and
Illustrator  if  these  applications  are  installed  in
your computer. 

In this way you will be able to insert any vector-based figure made in Corel Draw or Illustrator but
not bitmaps imported to Corel/Illustrator or word art. 

Once working with HotFix Era you will be able to edit the figures in the same way that you work
with the vector-based created within the application.

Note: For the correct performance of these utilities, it is necessary for Corel Draw  or Illustrator to be fully installed.

Paste Enhanced Metafile
Certain image creation applications allow you to copy an image file type
you are working on (Windows Metafile, EMF, etc.), to the Clipboard. This
is recommended for certain sketches with a high level of elements, or
when it is necessary to obtain more precision (better level of detail). You
may then paste it in Hotfix ERA using these commands.
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Create vector figures

With  HotFix Era you can create vectorial  figures in different
ways: from the Artwork  ribbon > Shapes group.

The  geometric  figures  available  to  insert  are  organized in
Shapes, Editor  and  Text  figures. You can also create vector
figures manually with bezier curves or freehand.

Bézier: This tool is based on the sketch possibilities that allow Bezier curves.

FreeHand: To trace freely open figures, drawing directly in the working area.

Shapes

To insert any of the figures,  choose the tool from the Artwork ribbon >
Shapes group. Form the list that appears, you have Basic and Advanced
Shapes; Extended Shapes; Puzzle1 and Puzzle2. Click on the desired
one. Then, press the left mouse button on a point of the working area
and drag without releasing it, while doing this the shape of a figure will
be progressively formed. To produce perfect  squares (if  working with
rectangles) or perfect circles (if working with ellipses), keep the Ctrl key
depressed while dragging the mouse. 

Once the outline has the size and shape you need, release the mouse
button. Immediately after creating the figure, it will become editable for
you to adjust its size and shape.

Editor
Hot Fix allows you to create vector figures
using a very easy interface.

Select  the  type  of  vector  you  want  to
create:  Polygon,  Star,  Lines  or  Spiral;
adjust some Parameters; 

Select  if  you  want  the  outline  or  a  solid
figure, and their corresponding color.

Press OK to create the figure.
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Vectors based on TrueType texts

Pressing this button opens a dialog box that allows you to
type text or lines of text, including selecting the font and size,
alignment and presentation.  

To create multi-line texts, once you have inserted the first text, press CTRL + Enter to begin a 
new line, and type the second text.

Once you have finished inserting the text, press the green check, to take it to the working window.

Any time a vector is selected, HotFix Era shows the Vector ribbon with all the tools to work with
them.

Editing Vector figures

Vector Objects Selection 

All vector figures inserted in Embroidery Office are editable, such transformations are done using
them together or modifying nodes individually.

To select any object located in the main work area press this button, click on the object you want.
Immediately see a box on it that lets you manually resize, while the ribbon changes to provide the
necessary tools needed to edit the object.
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Click on the  Select Object  button  to display  the selection
options: 

 

Select by rectangle

From  left  to  right:  Select  the  objects  that  are  fully  included  in  the  box
From left to right: Select the objects "crossed" by the rectangle.

Select by outline

Draw an outline "node to node" around the figure you want to select. When you finish surround
the object, press ENTER or mouse middle button and the object will be selected. This mode of
selection is really useful when you have overlapping figures.

Select all objects

Select all objects (vectors, images, embroidery and / or stone that are in the work area.

Invert actual selection

Change the selection excluding selected items and selected those that were previously outside
the selection.

Selecting two or more figures

To select several figures close between each other you can click on the working area and, without
releasing the mouse button, move until the dotted box embosses the figures you want to work on
(next page figures).

You can also select more than one figure by pressing the Ctrl key and clicking on the elements 
you are going to work on.

Instead, if  you press the Shift  key at the time of clicking two figures, you will  select all  those
objects that are between both figures in the corresponding sequence.
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Scale and Rotate graphically

In certain figures (for example the triangle) the
modification  points  appear  active  (left  image).
These allow you to change the original shape.

The  vector-based  figures  (either  created  from
HotFix  Era or  imported  from  different
applications) are liable to transform, modify their
curves, merge and convert to hot fix sections. 

You  can  expand,  compress,  rotate  and  move
images manually, in the same way you can do it
with any other image (right figure). 

Press the Ctrl key to rotate the figure or modify its rotation pivot. 

Press the Shift key to modify the size of the figure fixing its center.

If necessary, before you continue working with the figure, adjust its aspect and location, since by
dragging the corners you can proportionally modify the height and width at the same time, while
by dragging the pivots you expand or compress the figure in one direction (either the height or the
width). 

To move the figure to another location of the working area, simply place the mouse pointer to the
center of the figure and when this pointer changes its shape (cross with four arrows), click and
drag towards the desired position.

To perform modifications in more than one figure at the same time, simply select the figures that
will be involved in the modification and perform all actions on all of them at the same time.

These figures are placed following the order in which they were created, reason why some will be
on top of others.
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Edit Nodes

The vector-based figures are made of  nodes,  that  behave similarly to
those that make the embroidery sections. For more information about the
operation with nodes see chapter “Manual Basic Digitizing”.

Once the vector-based figure has been created you can modify the nodes
that give shape to it as well as the layout of each node’s handles.

To do so, click on the Select Object tool, and then on the  desired
figure. From the context menu, click on “Convert to Curves”, to see its
nodes.

Now that the figure has been converted into curves you will be able
to  alter  its  geometry,  modifying  the  location  of  its  nodes  and the
layout of its handles. 

You can also eliminate nodes, create new ones, etc. Operate on the
nodes in a similar way to that used when you work on the nodes of
an embroidery section. These options are available from the context
menu.

Vector Color and Format

This  box  allows  to  modify  the  border  and  fill  color  of  the
vector-based  figure  selected,  modify  the  border  width  or
add/remove it. 

You can choose a vector only with  fill,  only with  border or
both. In the left picture both are selected.

This option is useful for those cases where you must work on several overlapped figures.

On  the  right  figure  please  note  that  the  color  of  each  figure  has  been  modified,  improving
considerably the visualization of the elements.
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Setting colors from the color palette

The color bar or color palette may be used to set or change the border and fill color of vector
objects. With a vector object selected, clicking any color within the palette will fill that object with
the pointed color. Right clicking on the color, sets the border color for that object.

The first element in the color palette is a special item. It represents the “No color”
entry and may be used to remove the border and fill color of vector objects.

Clicking the no color item eliminates the vector fill color

Clicking the no color item with the right mouse button, eliminates the vector border

Managing Color Palettes
Edit this Palette: Allows you to access a dialog box
with options to select and edit a color palette.

Load, Save and Delete a color palette: Get a dialog
box that lets you work with color palettes.

Set this Palette as Default: Each time you open a
document vector, this color palette appears.

Reshaping Vector Objects

Vector Split

This  tool  allows  you  to  split  a  vector
object using an arbitrary line (defined by
a sequence of nodes).

Once the splitting line is defined, press
the Enter key, to execute the operation.

This tool is also available from the context menu.

Remove Holes

Automatically  deletes  all  the
holes  of  the  selected  vector
object.
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Combining vectors (Shaping)

Using the Shaping tools it is possible to create shapes resulting from
the intersection of two vector-based figures. Have in mind that if you
have  full  command  of  this  technique  you  will  be  able  to  sketch
complex shapes with little effort.

In  this  way,  the combination  of  several  shapes creates  one only
figure (in most cases), or performs modifications in the geometry of
both figures. You can combine the different types of figures available
in the application so as to create new shapes easily. The procedure
to combine figures is the following:

To give an example we will apply each of the described combinations to the figures presented in
the below figures, so you can observe the different results obtained.

Addition Substraction Intersection

Exclusion Trim Simplify

This tool is available from the Artwork – Vector – Layout ribbon > Combine group > Combine
Vectors or from the context menu. It is very useful whenever you have to work on vector-based
images,  since  some  shapes  are  made  up  by  several  figures,  and  many  of  them  can  be
overlapped.

In the three figures next see how the vector-based drawing is formed, pay attention to the number
of overlapping zones it has.
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In figure (a) appreciate how you view the image in EO 
Design’s Graphic View, see that it looks like one only element 
at first sight. 

Nevertheless, in figure (b) you can see the outlines of each of 
the figures that form the sketch. You can see that it is 
composed by several overlapping elements, one on top of the 
other. 

In figure (c) each of the overlapping zones were painted in 
gray. Note that there are darker areas, since several figures 
overlap there. 

Group & Ungroup Vectors

It is possible to group two or more vector-based figures to be considered a
unit.  In  this  way,  it  will  be  possible  to  move  them,  apply  the  same
transformations in shape and other changes to all the figures in the group at
the same time.

It is also possible to merge other groups already created, thus creating nested
groups. 

To create a group select the figures to activate the Group command from the Artwork – Vector –
Layout ribbon > Grouping group or from the context menu (Group Objects > Vectors group).

Ungroup and Ungroup all

To ungroup the figures that form a group, select the group and then choose the
option  Ungroup.  If  you  have created nested groups (groups  made by other
groups), the Ungroup command explodes just one level, while the Ungroup All
explodes all the groups and returns the original objects completely ungrouped.

This option is very important whenever you insert wmf or emf images, since it is made up by a
series of grouped vector-based images.
In order to edit any of these figures, you must first apply this function. 
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Two grouping levels Ungroup Ungroup All

Vector Order

In the edition of vector-based figures, you will  be able to modify
the  layout  of  the  vector-based  shapes  from  Ribbon  Vector  >
Grouping > Order or from the context menu options. 

The options are:

Front: It sends the selected element to the front, before the rest of 
the objects, placing it in the forefront.

Back: It places the selected object behind the rest of the objects.

Move Forward: The figure selected moves one level forward.

Move Backward: The figure selected moves one level backwards.

Accurate Size & position control

Once you have the image on the screen, whether it was in the disk or
scanned,  you  can  perform  certain  operations  such  as  expand  /
compress,  slant  or  rotate  the image.  To access these tools,  select  a
vector and press the Block Layout tab, Position and Size group.

Position: This button commands the movement on the vertical axis and the horizontal axis of the
figure. Take the center line marking the upper box surrounds the figure.

Size: This group lets you  precisely control the size of the object.  The padlock icon sets the
proportional mode: when pressed, changing one of the object's dimensions (width or height) will
automatically adjust the other in order to keep the object aspect ratio. When unchecked, you can
control both, width and height independently.
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Clicking on the small icon at lower-right corner will open a
box from where you may set the dimensions as a value or
percentage.

The options to rotate a vector by setting the rotation angle, works the same way as for bitmap
images.

Alignment

These functions allow you to place the vector figure on the left, right, top,
bottom or center, in both directions or in either of the two.

To access these tools, select a vector and press the Block  Layout tab,
Align group.

You will also be able to access the tools from the vector´s context menu.

To Object: This tools aligns the objects inside the block to left, right, top and bottom, using as
reference the leftmost, rightmost, upper and lower object of the block. You can also align the
objects center horizontally, vertically or both.

To Design: Contains tools for align the hole block with respect to the design, that is, with respect
to all other objects not included in the block.

Center at origin: Moves the center of the block to the system origin point (0,0)

Vector Repetitions

The following functions allow you to repeat one or more times the selected
figure/s. You can access these commands from Artwork - Vector - Layout >
Create Objects group or from the context menu options.

Duplicate

This command performs a copy and paste of the selected vector/s in only one step. It
always works on the active document.  Pressing the button more times makes another
copy of the selected vector/s you copied the first time.
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Matrix Repetitions

Use this function to duplicate the vector/s a certain number of times; the copies of the
vector/s will appear adjusted to a mold in the shape of cells. 

Define the number of rows, columns and the horizontal and vertical distance from the matrix cells.
To work with this tool, follow the procedure below: 

1)Select a group of vectors (paw) and from the Layout tab click
on Matrix Repetitions.

2) In the Matrix box set the number of rows and columns, and
the distance between them, horizontally and vertically.

Click on OK to see the result in the work area, the vector/s
will  repeat  a  number  of  times  depending  on  the values
entered.

In the example shown in the left figure we chose a number
of  2 rows and 4 columns to repeat the paw vector.

Contour with Offset

Use this function to create one or more vector lines, outside or inside the original vector's
shape outline (contour) separated a defined distance one from the other. 

After selecting Contour  with  Offset,  the “Create contour”  window will  open. You have several
predefined contour options to choose from: 

Outer  Contour,  that  makes  the  new
vector/s towards the outside of the original
vector;

Inner  Contour,  that  makes  the  new
vector/s towards the insides of the original
vector; 

Custom, lets you define whether you want
to  make  an  inner  or  outer  contour;  the
order in which the vectors will be made; the
number,  separation and color  of  the new
lines. 

Last Used shows the most frequent ones.

  Favorites shows all the ones which you have marked as favorites in Outer or Inner Contours. To
copy a predefined contour to the favorite tab, just go to the Outer or Inner Contour tabs, click on
the desired one and press the yellow star found on the same tab.

Also on the Inner and Outer Contour windows, you have an Edit button on the right that let´s you
see and modify the selected contour.
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Export Vector Images

Saving Vector Images to Disk

You can work on vector figures and use the tools provided by the application to
modify the vector graphics. Afterwards you can save the vector to disk directly from
the application.

From the ribbon Artwork-Vector-Layout > Export group > Save button...

Save the file under EMF format, compatible with many programs that use vector
graphics, DXF, PLT and SVG. Depending upon the format selected, the border and
body or just the border will be saved.

When you import or open vector images composed of many vectors, you must ungroup to start
editing each one of them.

If these vector shapes are not removed before saving the document it is saved with the design.
This is useful to change created saved forms in later editions.

Send Figures to Cutters

You can send a vector shape, a group of vector shapes or the entire vector image to
the  vinyl  cutter.  The  cutter  driver  provided  by  the  cutter  manufacturer  must  be
previously installed.

From the ribbon Artwork-Vector-Layout > Export group > Send Figures to Cutter...

When  you  press  Send,  the  system  will
display the standard Print dialog where you
need to select the cutter device and, through
the  Properties  button,  set  media  size,  pen
properties, etc. 

When you accept the Print dialog, a small box will prompt you to click Ok when the device were
ready. 

Load and align the media in the device and press OK to start cutting. 
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Using Vector images as...

Auxiliary images

They are loaded just to be used as reference for design creation.

When you enable the Simulation View, the Auxiliary images will  become
hidden. To view the auxiliary images again, just disable the simulation view.

Open the Object  Manager to see the Document Map, which consists of
several tabs. If  a vector image is only used as reference, it  should only
appear in this tab.

Cutter images

These figures are the ones that will be sent to the cutter device.

When you enable the Simulation View, the Cutter figures will be visible on
the workspace.

You can turn an auxiliary image to a cutter one, just by selecting the auxiliary
image and clicking on the Cutter button. The converted image will no longer
appear in the Auxiliary tab, but will be now shown in the Cutter tab.

Screen Printing images

You may load an image that is part of the final design, for example as 
backgroung of the embroidery. When you set an image as screenprinting, it 
will be showed, along with your embroidery objects, in the simulation window.

When you enable the Simulation View, the Screen Printing figures will  be
visible on the workspace.

You can turn an auxiliary or cutter image, to a Screen Printing one just by
selecting the desired image and clicking on the Screen Printing button. The
converted image will  no longer appear in the original tab, but will  be now
shown in the Screen Printing tab.

All images no matter what kind they are will appear in the ALL tab.
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Creating Hotfix Designs

HotFix ERA Objects
The software offers many types of  hotfix objects which can be used to create hotfix designs.
Those tools have been grouped in: Single HotFix and Assorted HotFix according to the number of
hotfix types present on the main fill. In addition, you may also create text with HotFix and place
individual HotFix manually. Some objects are lines (paths) and other objects are areas (regions),
on for both Single HotFix and Assorted HotFix groups.

Note:  The  number  of  available  HotFix  object  types  and  fill  styles  depend  on  the  purchased
product. Some of these features may be optional for standard products.

Choosing what object type is better, depends on the design feature you are working on: open
shapes should be digitized with paths, closed filled shapes with areas, etc.
Every object type has specific features, properties, and a specific tool to create it.

The creation tools can be 
enabled through different ways:

(1) From the HotFix Tab, on the
Insert HotFix Objects group, 
select the required object type 
and choose the fill style.

(2) From the Create Sections 
button, select the required 
object type and choose the fill 
style.

(3) Press the “Smart Design” 
button to access the Smart 
Design tool, and select the 
appropriate creation tool and fill
style.

About Nodes

The  following  paragraphs  introduce  the  HotFix  ERA objects,  their  elements,  fill  modes,  and
properties. The object's boundary (what we call the object's “main reference”) are built by inserting
a  sequence  of  points  called  “nodes”.  Nodes  are  more  than  simple  points;  they  have  some
properties that let you control how the system connects them: with a straight line, with a smooth
curve or with a sharp curve.

At the moment of manual tracing you can specify two working modes: Arc Nodes
or Bezier Nodes. According to which one you choose, the nodes will  behave
differently.

Though working with Circular Arcs, will be easier for you to capture geometric shapes, it generally
requires  the  insertion  of  more  nodes.  On  the  other  side,  working  mode with  Bezier curves
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requires a better skill when capturing shapes, but allows you to reduce the number of nodes that
form the geometry of a section. This mode is recommended for those users who normally design
with vector-based applications that use this type of curves (for example, CorelDraw®).

The default working curve type is Bezier but you can modify it to Circle Arcs from the Home ribbon
> System group > System Settings --> Application > Create & Edit > General > Curves type item.

Once a creation tool is activated, the ribbon changes to display the properties and controls that
apply to that specific object. 

All creation ribbons contain two groups; one, the Digitizing Methods from where you
can define whether to work with Bezier or Circle Arcs; 

and the other called Digitizing Objects from where you can control node’s properties. 

There are two basic node types:
Straight Type:

Represented by square nodes. 
Connects nodes with a straight 
line.

Curve Type:

Represented by circular nodes.

Connects nodes with a curved line.

There is an extra property for both node types, although its effect is more visible for curve nodes:

Normal Type:

Curvature  of  the  segments  on
both  sides  of  the  node  is  the
same. Displayed in white color.

Corner Type:

Curvature of the segments on both
sides of the node may be different,
letting you get a sharp point in the
shape.  Displayed in cyan color.

Note: If you switch a straight node between Normal and Corner you will not see any difference in the shape (just the node 
color will change). However, it may have impact on the beads placement because the system will always try to place a bead 
at the corner nodes.

Curve nodes have also a special control that lets you define the curvature of the segments at both
sides of them. These controls, called “handles”, are small segments with a dot at the end that you
can move (by dragging them with the mouse) to establish how the curved segments behave at the
node.

The picture at the left shows the same
curved  node  with  three  different
positions of the handles. Handles may
be moved near or far from the node to
get  a  sharper  or  smoother  curve  and
may  be  rotated  around  the  node  to
change concavity.

There is a property for normal curve nodes that adds some extra control for the handles:
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Symmetric:  Force that  both handles are the same size,  making the curvature of  the
segments at  both sides of  the node, equal.  When you move one of  the handles,  the
opposite ones is automatically moved at the same distance with respect to the node.

Uniform:  Both  handles  may  be  set  at  different  distances  with  respect  to  the  node,
although they are forced to remain aligned.

When  the  curve  node  is  marked  as  a
corner,  its  handles  may  be  set  at
different distances from the node and
may have different directions.

The picture shows the same corner curve
node  with  different  positions  of  its
handles. Note that handles may be set
at any distance from the node and they
are not aligned.

Paths
Paths are linear objects, with beads arranged along them. They are simply defined by
a sequence of nodes. They may be open or closed, may have smooth or sharp curved
segments  (controlled  by  the  properties  of  its  nodes)  and  also  may  intersect
themselves.

One basic fill mode is available for this type of object: beads are arranged along the path, trying to
keep the same distance between them. The properties to control this placement (the fill mode
properties in HotFix ERA terminology) are:

Beads Spacing: Controls the space between beads. A distance of 0 (zero)
means that beads are “touching” its neighbors.
Fitting mode: This  property  controls  how beads  are  spread along the
path. Four options are available (from left to right):
Path: This is the default and more common option. Beads are uniformly
placed along the path, but considering:

Always  a bead is  placed in  the position of  the first  and  last  node and
always  a  bed is  placed at  the  nodes  where  direction  of  the  segments
changes abruptly.

References: The system places beads at the position of nodes only. The
value entered for  Distance value is ignored.

Path + References: The system places beads at the position of the nodes
and fits additional ones between them using the configured Distance value.

Paths + Corners: Similar to the Path option, but with an extra rule: Always
a bead is placed at the corner nodes.
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Angle mode:  Non round beads may be oriented, that  is,  place rotated
(with respect to its center) at different angles. Orientation may be fixed (all
beads  at  the  same  angle)  or  may  be  variable,  considering  the  path
direction.  This  property  has  three  options  that  let  you  control  beads
orientation (from left to right):
Perpendicular:  Beads  are  oriented  following  a  variable  direction
perpendicular to the path.

Tangent: Beads are oriented considering a direction tangent to the path.

Fixed: This is the default option. All beads are placed at a the fixed angle
indicated in Angle Value.

Angle value: Available only for Angle Mode = Fixed, indicates the angle
used to rotate the beads. The default value is 0 (zero). Angle is measured
with respect to the document horizontal axis.

Bead Type:  This  control  lets  you  select  the bead you will  use  for  the
object. Clicking on it unfolds the current bead palettes that allows you to
select any of the pieces contained on it.

Note: The distance between beads is not exactly preserved all the time. To fit beads properly, the system smoothly adapts the
distance using the entered value as a mean value.

Areas
The term Area refers to an object defined by a closed boundary. Normally, beads are placed in the
inner  region  of  the  area  and,  optionally,  also  along  its  boundary.  HotFix  ERA defines  some
additional elements for the area objects:

Holes:  Are regions inside the main reference, where no beads are placed. Once the main
reference was created, select Hole from the Element group at the ribbon, to add a hole to
the area object. Holes are closed shapes, so, if you created an open shape, the system will
close it automatically.

Direction lines: Are special geometric references, used in some fill modes, to guide the
beads placement. Directions are open shapes, build with straight and/or curve nodes in a
process very similar to the Path object creation. To add a direction you just need to click the
Direction button located at the Element group in the ribbon bar.

Area  objects  support  a  combination  of  fill  modes,  one  for  the  inner  region  and  one  for  the
borderline. Borderlines are simply processed as closed paths.  For the inner region, there are four
fill modes available: Uniform Fill; Inner Ring Fill; Flexible Fill and Flat Fill. The basic difference
between them is the style in which the beads are arranged, producing different visual effects.
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Areas with Hotfix Uniform Fill

Hotfix Uniform is a fill mode designed to produce the best possible coverage of the area
region. The placement algorithm tries to generate the most uniform placement possible,
considering the shape, the bead size and the specified beads separation.

The picture on top shows an Area object main reference, with two corner nodes, in cyan, and two
normal curve nodes. On the right, the same object  showing the fill, radial hotfix and borderline.

When creating and editing area objects, the ribbon displays two tabs named Body and Border.
Body tab contains all the controls to set the properties for the inner region fill and Border tab, for
the borderline. Controls in the border are the same you find for a path object.

The properties to control the radial fill mode (Body tab) are:
Beads Spacing:  Controls the space between beads. A distance of  0 (zero)
means  that  beads  are  “touching”  its  neighbors.  If  bead  type  is  sequin,  a
negative value, that produces some overlapping, is allowed.

Margin from Borders: Set a distance from the borderline where no beads are
placed.

Initial Layout: Radial fill  is based on a special algorithm that starts from an
initial  placement  and  then  moves  the  beads  to  set  them equidistant.  Initial
Layout property lets you select two possible starting placements. The  Radial
option tends to produce a placement that slightly follows the shape of the object
and  the  Hexagon option  produces  a  more  uniform,  shape  independent,
placement.

As in all fill modes, you can select the bead you will use with the control on the right of the Area
Fill group. This control always displays a real view of the bead type currently selected for the
object.

Areas also let you change the fill mode on the fly. Pressing the control on the left of the group,
unfolds a menu with the available fill modes.
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Areas also let you change the fill mode on the fly. 

Pressing the control on the left of the group, unfolds a menu with the
available fill modes.

The number of modes depend on the system level you acquire.

Areas with Hotfix Inner Ring Fill

In this fill  mode, the system calculates a group of interior rings and places the beads
along them. The special feature of the Variable Distance fill mode, is that you can control
the separation between the rings, in a one by one basis, allowing beads density gradients
that produce interesting effects.

Ring fill mode is better suited for large area objects with small beads. This  combination allows
that several rings may be fitted inside the shape so the distance variation effect may become
evident.
The properties to control the Variable Distance fill mode (Body tab) are:

Beads Spacing: Controls the space between beads along all of the rings. A distance of
0  (zero)  means  that  beads  are  “touching”  its  neighbors.  If  bead  type  is  sequin,  a
negative value, that produces some overlapping, is allowed.

Margin from Borders: Set a distance from the borderline where no beads are placed.

Pattern: This button displays the Rings Pattern dialog box. This tool lets you use any of
the Radial Patterns included; or to edit them to create a new one.
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The  Rings  Pattern  box  shows  some
Radial  Pattern  samples  you  can  use.
Click  on  the  All option,  select  one  and
press OK. 

You can also  edit  any of  them,  change
their configuration and use it right away. It
will appear under the Custom option.

To access any Ring Pattern quicker, add
it to the Favorites tab, first select one of
the  available  ones,  and  afterwards
clicking on the yellow star. It will appear
on your Favorites tab.

Choose any pattern,  for example the one named RI11-001,  press the Edit button to  see  the
number of rings the pattern has, and a preview pane on the right. 

The Rings control is set to 1 and the list contains just one row. You may define as many rings as
you want, however:

• If  the  number  of  defined  rings  and
their  separations  produce  a  pattern
that is not enough large to completely
fill  the object,  the system will  repeat
the pattern starting with ring 1.

• If  the  number  of  defined  rings  and
their  separations  produce  a  pattern
that  does  not  fit  inside  the  object,
some  rings  will  be  ignored.  In  this
case,  the  system  shows  a  warning
message and the ignored rings will be
marked with * in the list.

The Rings Pattern settings in the picture  above was used to fill the star design shown in the
previous page. Seven rings were defined. The separation between them was increased from
ring to ring to produce the vanishing effect.

The red line in the Preview panel indicates the object boundary. The black background region
represents the object interior.

Observe that the last ring falls outside the black region, meaning that it will not fit and will be 
ignored. For this reason the warning message appears at the bottom and the ring 7 is marked 
with *. If you scale the object, maybe the object that does not fit in, will fit. 
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Angle mode:  Non round beads may be oriented, that  is,  place rotated
(with respect to its center) at different angles. Orientation may be fixed (all
beads  at  the  same  angle)  or  may  be  variable,  considering  the  path
direction. 

This  property  has  three  options that  let  you  control   beads orientation
(from left to right):

Perpendicular:  Beads  are  oriented  following  a  variable  direction
perpendicular to the path.

Tangent: Beads are oriented considering a direction tangent to the path.

Fixed: This is the default option. All beads are placed at a the fixed angle
indicated in Angle Value.

Angle value: Indicates the angle used to rotate the beads. The default
value is 0 (zero).

Areas with Hotfix Flexible Fill

Flexible Hotfix is a powerful fill mode that allows you to create a beads placement that
is guided by an almost arbitrary direction line.

This fill mode requires that a new element to be defined, the direction line. It’s a simple,
open line, built from a sequence of nodes (straight and curves).

Basically, the placement is generated using a set of imaginary lines
(with the same shape than the direction line). 

Beads are then placed along these line in a row by row basis. 

So, this fill mode includes properties not only to control beads spacing
along the “imaginary” rows but rows spacing as well.

Once you complete the input of the main reference, from the Elements group in the Hot
Fix  Area  Body ribbon,  click  on the  Direction icon.  Then just  start  creating  a line that
crosses the main reference, like in the picture above right. Press Enter to confirm.
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Direction line is not mandatory; you may enter it or not. In the last case, the system uses an
internal and invisible,  horizontal straight line. The Body tab of Flexible fill  shows the following
properties:

Beads Spacing: Controls the space between beads along a row. A distance of 0 (zero)
means that beads are “touching” its neighbors. If bead type is sequin, a negative value,
that produces some overlapping, is allowed.

Rows spacing: Controls the spacing between rows.

Margin from Borders: Set a distance from the borderline where no beads are placed.

You can select the bead you will  use with the control  on the right of the Area Fill group. This
control always displays a real view of the bead type currently selected for the object.

These Area types also let you change the fill mode on the fly. Pressing the control on the left of
the Area Fill group, unfolds a menu with the available fill modes.

Areas with Hotfix Flat Fill

Hotfix Flat fill mode produces a regular, column by row based, beads placement. Better
suited  for  large  or  very  geometric  shapes,  it  does  not  require  additional  geometric
references and allows you to control column and row spacing, beads angle, etc.

Properties available in the Body tab for this fill mode are:

Columns spacing: controls horizontal beads separation.

Rows spacing: controls vertical beads separation.

Beads Offset: Sets an initial displacement for placement of beads in even rows. Grid fill
mode produces regular, vertically and horizontally aligned placement.,  but sometimes,
shapes require a bit irregular placement. Offset helps this avoiding the vertical alignment.
The value is a percentage. Best effect is obtained with 50% offset.

Beads angle: Set the rotation (around its center)  angle of  the beads.  Useful for non
round pieces.
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Border mode: Instructs the system how to place beads at the object boundaries. Inside
option (upper left), forces to remove the beads that are not completely inside the object
boundaries. Outside option (lower left) allows beads that are placed crossing the object
boundaries.

Placement  Tolerance: Usually,  if  columns and rows spacing  values are  considered
strictly,  some beads  do  not  fit  and  should  not  be  placed.  However,  sometimes  the
placement would look better if  some pieces in that situation were allowed. Tolerance
controls how strictly the system behaves in these “limit” situations. A value of 0% (zero)
means no tolerance at all, and larger values relaxes the placement rule allowing some
“limit” pieces to be included.

Areas with Hotfix Grading Fill
OPTIONAL
FEATURE

Grading fill mode produces a bead placement where the spacing varies gradually along
a specified direction allowing the creation of interesting volumetric effects.  

Basically, you define a “variation line” and indicate an initial and final spacing values.

By default, the system places the variation line starting at the center of the area object and
ending  near  the  area edge;  initial  spacing  is  set  by default  to  a  value  lower  (more dense
placement) than the final spacing, but you may change it according to your needs.

You need to access the context menu and select Customize Hotfix Area to display the variation
line. You may drag the line ends (square and triangle marks) to modify the line size and position.

An additional rectangular mark (called average spacing cursor) defines the position where the
beads spacing will be set to the average value between the initial and final ones. You may drag
the cursor  (always  on the line)  to  any position.Once the line is  defined,  it  rules the beads
spacing and the system will place the beads with spacing values that will vary gradually from
initial to final values.

Properties available in the Body tab for this fill mode are:

Initial Spacing: controls beads spacing at the starting point (square mark)
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Final Spacing: controls beads spacing at the ending point (triangle mark)

Half Grading Point: Defines a point where spacing is the average value between
Initial and Final values. Position of this point is represented as a value in the range
0.1 to 0.9, where 0.1 is located near Initial point and 0.9 is located near Final point

Grading  Variation  Mode: This  control  defines  how  spacing  variation  is
accomplished.  Radial  mode (lower left)  produces  variation following concentric
circles around the Initial point, while Linear mode (lower right) produces variation
following an imaginary line perpendicular to the direction line.

Areas with Hotfix Textures

Textures are predefined bead's arrangements that can be used to fill area objects. You
may imagine the textures as a large pre-built design where your area objects behaves
like a clipping boundary.

You may select what region of the texture is clipped by your area and even scale the texture so as
it better fits your needs. The idea behind textures is to allow you to create artistic and geometric
complex and time consuming bead placements, in a very short time and with just some few clicks.

The basic steps to use textures are:

1- Within the Hotfix ribbon, select Area with  Assorted Hotfix  Fill  and then Area with Texture  Fill.
The system displays the Hotfix Area Body ribbon, with the Default texture selected.

2- Create the area object as usual. Consider that texture fill is intended for medium to large size
areas. You may not appreciate the texture pattern if you use very small areas. As a guideline,
avoid objects smaller than 50 x 50 mm.

3- Once the area contour is completed, the system will  show a sketched view of the texture,
drawn  using  a  contrast  color.  In  this  state,  you  may  move  the  texture  regarding  your  area
boundaries by simply dragging with the mouse; also, if you drag while holding the Shift key, you
may scale the texture pattern. If you hold the Ctrl key and drag you may rotate the texture.

Textures are designed using a predefined bead type and spacing. However,  you may change
them using the ribbon controls during creation or later, during edition. Again, consider that using
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large size beads or large spacing values may produce poor results. Scaling down too much may
also lead to this.

4- Once  you are  satisfied with  the  texture's position,  scale and bead type,  press Enter.  The
system will calculate the beads placement and display the result.

Initial texture sketched view Move, scale and rotate Texture generated

Properties available in the Body tab for this fill mode are:

Initial Spacing: controls the spacing between beads along the lines that form the
texture.

Texture: Lets  you  select  the  texture  model  among  the  ones  available  at  the
texture library. When you click on it, the Texture Library dialog pop-ups and you
may graphically select the texture component to use

Beads List: Textures are multiple beads components, that is, a given texture  may
use more than one bead type. This control allows you to modify the bead type for
every bead type used in the texture. When you click on it, the system first displays
a list of the bead types used, inviting you to select one of them. Once do it, the
bead bar list is displayed so you may select a different bead type. You may repeat
this operation for every bead type used in the texture.
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These  properties  may  be  also  changed  through  the
Object  Inspector.  Using  it,  you  may  also  change  the
vertical and horizontal scale, position and rotation of the
texture. The Bead List group will display a row for every
bead type used and, when you click on any of them, a
list with your current bead bar contents will appear.

During edition,  from the context menu, select Texture to
enter  the texture graphic edition mode (mouse drag to
move, scale and rotate).

Fill  types  with  multiple-beads  required  a  new
configurable option to control the system behavior at the
moment to use a component that includes a bead type
that is not currently within the bead bar.

Textures are designed using a given set of bead types. Although you may change them, you need
to do it carefully, because some details of the textures may be lost if you, for example, use a bead
size  much larger  than  the original.  Also  the  distance  among the  different  features  within  the
texture may become too close if you use very large bead types.

To make it simpler, the system, by default, will use the bead types predefined within the texture,
adding them, if necessary, to your current bead bar.

You  may  control  this  behavior  using  the
Options and Preferences dialog. Use the tree
list at the left and select  Application > Project
> Hotfix. Then, at the right panel, the check
labeled  “Add  beads  to  palette  when
necessary”  will  let  you control  if  the system
automatically  adds  beads  to  bead  bar
(checked) or not.  If  you uncheck the option,
the system will  assign the first  bead in your
current  bead bar  to  the  bead  type  1  in  the
texture, the second to the bead type 2, and so
on.

To change the existing texture of your design, just click on the Ellipsis button […] to open the
“Select a Component” window, and choose another Texture.

Click on Texture, select one and press OK. 

To access any texture quicker, add it to the Favorites tab, first select one of the available ones,
and afterwards clicking on the yellow star. It will appear on your Favorites tab.

You can also click on any with the red padlock, and click on Buy Component to be able to
purchase it and add it to your library of available textures.
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Areas with Hotfix Spectacular Fill
OPTIONAL
FEATURE

This fill  mode is slightly different  from all  the others;  the reason is  that  the beads
arrangement it produces is located outside the area region, instead of inside it.

Just a simple example will make it a bit clear:

Star shaped area object The object with Spectacular Fill
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The Spectacular fill spreads beads, with variable density, around the defined object. How far the
beads are spread and the density variation used are easily and graphically controlled and also the
shape of the “spreading pattern” may be selected among several shape options.

The basic steps to use Spectacular Fill are:

1- Within the Hotfix ribbon, select  Single Hotfix Fill and then Area with Hoftfix -  Spectacular Fill.
The system displays the Hotfix Area-Body ribbon.

2- Create the area object as usual. Consider that this fill mode spreads beads outside the object,
so check you have enough clearance around the object.

3- Once the area contour is completed, the system will create the
effect  using  the  current  density  and  shape  values.  Click  on  the
Select Object tool (or press F11) and the system will enter to edition
mode for the object you have just created. Get the context menu
(right  click)  and  select  Customize  Spectacular  Fill  Density:  the
system will display a line with a square mark near the object center,
a rectangular cursor at the middle and a triangle mark at end. Drag
the triangle mark to change the size of the shape effect, drag the
square mark to change the effect shape center and slide the middle
mark to change the average spacing position (see properties next).

These handles let you almost completely control the effect. To change the shape of the spreading
pattern, you need to use the Effect Shape control at the ribbon bar.

Take a look to the available properties. They are quite similar to the Variable Density fill mode:

Initial Spacing: controls beads spacing at the shape's center (square mark)

Final Spacing: controls beads spacing at the shape's outline (triangle mark)

Half  Grading  Point: Defines  a  point  where  spacing  is  the  average  value
between Initial and Final values. Position of this point is represented as a value in
the range 0.1 to 0.9, where 0.1 is located near Initial point and 0.9 is located near
Final point.

Effect Shape: Defines the shape of the beads pattern. The shape will  always
surround the object. The shape size is controlled graphically.

Curve: Creates a shape effect similar to the object shape

Circle: Creates a circular or elliptical shape

Rectangular: Creates a rectangular or square shape

Round Rectangle: Creates a round-rectangular or square shape
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Areas with Hotfix Outer Ring Fill
OPTIONAL
FEATURE

In this fill mode, the system calculates a group of exterior rings and places the beads
along them. The same as the inner ring fill, the special feature of the Variable Distance
fill mode, is that you can control the separation between the rings, in a one by one
basis, allowing beads density gradients, to achieve incredible effects.

Ring fill mode is better suited for large area objects with small beads. This  combination allows
that several rings may be fitted outside the shape so the distance variation effect may become
evident.
The properties to control the Variable Distance fill mode (Body tab) are:

Beads Spacing: Controls the space between beads along all of the rings. A distance of
0 (zero) means that beads are “touching” its neighbors. If bead type is sequin, a negative
value, that produces some overlapping, is allowed.

Margin from Borders: Set a distance from the borderline where no beads are placed.

Pattern: This button displays the Rings Pattern dialog box. This tool lets you use any of
the Radial Patterns included; or to edit them to create a new one.

The  Rings  Pattern  box  shows  some
Radial  Pattern  samples  you  can  use.
Click  on  the  All option,  select  one  and
press OK. 

You can also  edit  any of  them,  change
their configuration and use it right away. It
will appear under the Custom option.

To access any Ring Pattern quicker, add
it to the Favorites tab, first select one of
the  available  ones,  and  afterwards
clicking on the yellow star. It will appear
on your Favorites tab.

Choose any pattern,  for example the one named RO11-001,  press the Edit button to  see  the
number of rings the pattern has, and a preview pane on the right. 
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The Rings control is set to 1 and the list contains just one row. You may define as many rings as
you want.

The Rings Pattern settings  in  the left  picture was used to  fill  the heart  design shown in  the
previous page. Three rings were defined. The separation between them was increased from ring
to ring to produce the vanishing effect. The red line in the Preview panel indicates the object
boundary. The black background region represents the object exterior.

Angle mode:  Non round beads may be oriented, that  is,  place rotated
(with respect to its center) at different angles. Orientation may be fixed (all
beads  at  the  same  angle)  or  may  be  variable,  considering  the  path
direction. 

This  property  has  three  options that  let  you  control   beads orientation
(from left to right):

Perpendicular:  Beads  are  oriented  following  a  variable  direction
perpendicular to the path.

Tangent: Beads are oriented considering a direction tangent to the path.

Fixed: This is the default option. All beads are placed at a the fixed angle
indicated in Angle Value.

Beads angle: Set the rotation (around its center)  angle of  the beads.  Useful for non
round pieces.
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Ray Hotfix Column
OPTIONAL
FEATURE

In this fill mode, the user defines a column type section, in which the system will place
the beads along a series of rays which are oriented parallel to the column's directions
(defined by consecutive pair of nodes). You can control the  separation between the
rays, and a random edge fill on them.

In  a  Column  type  section,  the  main  reference  is  formed  by  guides.  These  are  defined  by
sequenced pair of nodes, which establish directions within the column. These guides define both
the section’s geometry and the direction of the rays. A section of this type is formed at least by two
pair of nodes. 

The basic steps to use Ray Hotfix Column are:

1-  Within the  Hotfix ribbon, select  Single  Hotfix  Fill and then  Ray
Hoftfix Column. The system displays the Hotfix Vector-Body ribbon.

2- Create the column object  as usual,  that  is,  insert  at  least  two
pairs of nodes that will work as directions. 

3- Once the column has been completed, the system will create the
rays effect using the current ray type and separation values. Click
on the Select Object tool (or press F11) and the system will enter to
edition mode for the object you have just created. 

4- Open the Object Inspector to see the property values.

The properties to control the Ray Hotfix Column (Body tab) are:

Rays Density: You have two choices: Use Ray Separation or Use Ray Count.
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Ray Separation: Stablish the distance in mm. Between each ray.

Ray Count: Stablish the number of rays inside the column.

Insert Ray On: Define if rays are going to be stablished on:

References: where the column nodes were located

References+Interior: where the column nodes were located + the ray separation

Beads Spacing:  Controls the space between beads along the rays.  A distance of  0
(zero) means that beads are “touching” its neighbors. If bead type is sequin, a negative
value, that produces some overlapping, is allowed.

Margin from Borders: Set a distance from the edge of the rays where no beads are
placed.

Angle mode:  Non round beads may be oriented, that  is,  place rotated
(with respect to its center) at different angles. Orientation may be fixed (all
beads  at  the  same  angle)  or  may  be  variable,  considering  the  path
direction. 

This  property  has  three  options that  let  you  control   beads orientation
(from left to right):

Perpendicular:  Beads  are  oriented  following  a  variable  direction
perpendicular to the path.

Tangent: Beads are oriented considering a direction tangent to the path.

Fixed: This is the default option. All beads are placed at a the fixed angle
indicated in Angle Value.

Beads angle: Set the rotation (around its center)  angle of  the beads.  Useful for non
round pieces.
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Random Edge: The beads may cover the ray path in a randomly way. You have three
choices:

 Side A

 Side B

 Both Sides

Random Factor: Percentage of the complete ray that will be not filled completely with
beads, but randomly.

Path and Areas with Hotfix Assorted Fill
OPTIONAL
FEATURE

The  software  counts  with  a  toolset  for  the  creation  of
HotFix  objects,  where  the  main  fill  rhinestones  (or
sequins) of several shapes, colors and sizes at the same
time..

These tools enlarge the diversity and variety of creative fills for the creation of HotFix designs.

These kind of fill styles may have limitations in some cases (with some geometric shapes). The
user must check that the resulting objects match to the expected result. The user must also check
in detail when the used components are of different shapes and sizes, because the proximity of
the component may produce undesirable results, even overlapping.

Manual Hotfix

This tool lets you insert one, isolated, hotfix piece anywhere in your design. Very
useful to add some special pieces, sometimes large ones, normally used in very low
quantities, or to complete the placement generated by the system for a given object.

To add manual pieces, just activate the tool from the Hotfix ribbon, select a bead from the bead
bar and click where you need to place it. 

When the Manual Hotfix tool is active, the ribbon shows position, angle and bead type properties
that let you control, accurately, the bead placement.
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Hotfix Texts

Texts are very powerful objects allowing you to easily create legends with hotfix pieces.

HotFix ERA lets you to create hotfix text using a set of detailed, pre-digitized fonts, and also using
the TrueType  ® fonts installed in your computer. HotFix ERA Text features include a complete
manipulation of size, orientation, spacing (characters, words, lines) of texts and characters inside
texts, text layout effects (like arc, bridge, diamond, etc) and more.

Due to the extense possibilities text objects offer, we have prepared a special chapter, the next
one, totally dedicated to texts object.

Creating Hotfix objects

Producing a hotfix design, from the idea to the garment, basically involves:
- Artwork: Some kind of drawing, sketch, image or good specification related with the art

behind the design.
- Planning: You need to know the size of your design and what hotfix pieces will be used.

The knowledge about how the design will be transferred to the garment (machine, stencil,
manual) may also help.

- Object Creation: As mentioned, this task known as “Digitizing” refers to the process to
convert the artwork into objects and set the properties that control the beads placement.

- Export the design: Once the design is finished, you need to produce some type of output
to move the design from the computer to the garment.

In this section we will focus on the Object Creation task or Digitizing. We will assume that an
artwork image (of any type, unless specified) is displayed as screen background.

The chapter Images and Vectors contains detailed information about the HotFix ERA tools for
working with artwork files.

Manual Digitizing

The  term  Manual  Digitizing  means  that  objects  creation  is
accomplished by tracing the artwork shapes manually.  You need to
select the proper creation tool (path and area basically) and place the
nodes  using  the  background  image  as  reference  and  trying  to
reproduce the features of the shapes in the artwork.

Selecting the bead type you will use and setting the fill mode properties may be done before or
during creation or, after creation (edition). Usually, the basic settings are done during creation and
then adjusted (edited).This process is repeated for each shape in the artwork.
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Assisted Digitizing: Autotrace

Autotrace is a time saving tool that automates the process of tracing
the  artwork.  Instead  of  manually  placing  the  nodes  to  capture  the
shapes in the artwork, the system automatically detects them (based
on its color) and creates the objects reference for you.

To use this feature you just need to select Autotrace within the Digitizing Methods group, located
on  the left side of the path and area hotfix object ribbons. Autotrace is disabled if  there is  no
image loaded on the working area.

When used with raster images (pixel based images), the key for success is the image quality:

1- The  minimum  recommended  image  size  is  around  125  pixels  per  inch  (5  pixels  per
millimeter). So, if your design has to measure 4” x 4”, the image size should be at least 500 x
500 pixels.

2- Image colors have to be “solid” for proper recognition. Sometimes, a region that seems to be
light blue is made of a mixture of blue and white pixels.

3- Shape borders should be well defined. Usually, the process of scaling an image, introduces
an effect called blur that is not good for automatic recognition. A shape border in a good
image is a clean edge with different colors at both sides, while in a blur-ed image you can
note a graded transition between colors. Shadows and light effects are also bad for automatic
tracing.

Take a look at a brief example about Autotrace usage. We will use a raster image called ASR-025
included with the system and scaled to 5” (125 mm) wide.

Step 1 - Select creation tool

We will digitize the Indian face using an Area with Hotfix - Uniform Fill and
Radial Fill initial layout . As the shape size is not so large, we will select a
small, 4 SS (1,7 mm.), round rhinestone crystal red.

Step 2- Select tracing mode

From the Digitizing Methods group, to the left side of the HotFix Area Body
ribbon,  click on Auto to open the list  of  options,  and click  on Autotrace.
When you move the mouse pointer  into  the working area,  you’ll  note a
special mouse cursor.
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Step 3 – Trace

Move the mouse pointer over the shape representing the
indian face and click  on it.  The shape borderline will  be
recognized and will  be surrounded by a flashing dashed
line.

In the group Area Fill, check that the Bead spacing is set to
1 mm  and Margin to  0;  and  that  Radial  is  set  as  initial
layout. 
Hit  the enter  key.  The  system will  generate the required
beads placement to fill in the shape.

Step 4 – Continue creating.

Once the first object is created, the system will  be ready for the
next one. Move the pointer to red shape above the face, click on it
and hit enter. Repeat the process with all red shapes in the artwork.

Hide the image to check the result. To do it, just click on the
word Auxiliar at the top-right of the working area.

During tracing, you have the chance to modify the recognized
region before creating the object main reference. The context
menu lets you expand and contract the recognized shape.

These tools are useful to create objects slightly smaller or larger
than the artwork shape. You can also remove small regions and
inlets and smooth abrupt shape changes using the tool Remove
Narrow Regions.
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Filtering example: Note how narrow inlets were removed by the filter.

Autotrace helps you creating one reference at a time. If the shape you are tracing has a hole,
once you created the main reference, before hitting Enter, select Hole and then use the autotrace
again to capture the hole reference. Even more, you may switch to manual mode on the fly and,
eventually, create the hole reference manually. After the hole has been traced, press Enter.

Automatic Digitizing: Auto Complete

Auto  Complete is a full automatic digitizing tool. Although the procedure to
use Auto Complete is almost identical  to the Autotrace procedure, it creates
all  the  object  references  at  a  time,  that  is,  the  main  reference  and  the
references for all holes the shape has.

Even more, Auto Complete lets you trace several shapes at a time, creating several objects, of
the same type and fill mode: Once the first shape was traced, press and hold the Ctrl key and
trace another one. When you press Enter, the two objects will be created at the same time.

Digitizing using Geometric Shapes

Creating  objects  from  Geometric  shapes  is  another  semi-automatic  digitizing
method.  It helps you to create the object references (main reference and holes)
from a library geometric shapes. They are available for path and area objects.

Using this tools is very simple. See the example next.

Creating a path with a geometric shape

Step 1 – Select the path tool and set the Digitizing Mode to manual. For this example, we will
use a round rhinestone with a diameter of 2 mm. (6ss), Aquamarine Color. Set Bead spacing to
1 mm, Angle Type Fixed with Bead Angle value of 0 (zero) degrees. Set “Add Beads on” Path.

Step 2 -  Click on Shapes. Within the gallery,  scroll  down to the category
named Advanced Shapes and select the shape named AAS_022 showed in
the right picture.

Move the pointer into the working area and drag the  mouse. The shape will
appear  and will  start  to  scale  up  following  the  mouse  move.  Set  a  size
around 60 x 57,7 mm. You may press and hold down the Ctrl key to scale the
shape proportionally.
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Step 3 – Release the mouse button and hit Enter. Press Ctrl+F9 to generate
the beads. You have just created a path object with an aspect similar to the
one showed in the picture on the right.

Editing Hotfix objects

Once created, modifying the hotfix objects is a very simple task. You just need to activate the
Select Object tool and click on the object you want to edit. HotFix ERA will highlight the object,
display its nodes and refresh the ribbon, toolbars and other views to give you access to the object
properties and geometric elements.

Selected objects are surrounded by a set of special handles that allow you to move, scale and
rotate it. Also, within the ribbon bar, appears a tab named Layout with alignment and repetition
tools among others.

Selecting  the  objects  for  editing  is  a  topic  by  itself.  The  following  paragraphs  introduce  the
available selection tools.

Object Selection tools

The second button on the auxiliary toolbar, located above the working area, is the selection tool.
Clicking on the button activates the powerful selection tool. Depending on how you use the tool
and which controls you activate when you are making a selection, you get a different behavior and
results.

If you click on an object, it becomes selected.

If you click and drag left to right, the tool lets you select by
rectangle. A shaded rectangular box, with one corner fixed
at the position you start dragging and the opposite located
in the current mouse pointer position, is displayed on the
screen. When you release the mouse buttons, all objects
totally inside the rectangle are selected.

If you click and drag right to left, the tool lets you select by
“crossing  rectangle”.  In  this  mode,  objects  totally  or
partially included in the rectangle are selected.
If  you  press and hold the Ctrl  key,  a click on an object
adds it to the selection set. Once an object is added, a
new click on it removes it from the selection set.

Clicking on the arrow pointing down, unfolds the selection menu, with extra selection tools.
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Select by Rectangle: Is the default mode mentioned in the above paragraph.

Select  by  Outline: In  this  mode,  you  create,  click  by  click,  a  free  shaped  outline
surrounding the objects you need to select. Once did it, access the context menu and
select OK to instruct the system to select all objects included inside the defined outline.

Select All: Automatically selects all objects in the design

Invert Selection: Creates an inverted selection set, that is: all currently selected objects
are unselected and all currently unselected objects are selected.

Hotfix piece edition tool

This tool lets you modify an individual hotfix piece, no matter if the piece belongs to an
object filling or is a manual hotfix piece.

Once the tool is activated and a bead selected:
 Drag to move the piece.
 Press and hold Ctrl key to display the rotation handles. Drag them (always holding Ctrl) to

rotate the piece. Rotation center may be also dragged to move it where required.
 Press Delete key to remove the piece
 Press Shift key and drag to initiate an on the fly piece insertion.
 Click on the bead bar or use the beads gallery within the ribbon to change the bead type.
 You can also use the Position and Angle controls within the ribbon to accurately edit the bead.

Working with Hotfix Objects Blocks

Any time you use the selection tools, the resulting selection set (even if it contains just one object)
is considered as an object block. As described previously on Object Selection Tools, you can
create a block using any of the selection methods. Once created, HotFix ERA draws a dashed
box around the objects.
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The box has eight grips or handles (in the corners and in the middle of each side).

 Drag any corner handle to produce a proportional scaling of the block, keeping the opposite
corner in place.

 Press and hold the Shift key and drag a corner handle to produce a proportional scaling but
keeping the block center in its place.

 Drag any side handle to scale horizontally or vertically, keeping the opposite side in its place.

 Press and hold the Shift key and drag any side handle to scale horizontally or vertically but
keeping the block center in its place.

 Press and hold the Control key and drag the corners to rotate the block around the rotation
center. Holding the Ctrl key you can also drag to move the rotation center where you need.

Scale proportional Non proportional scaling Rotate

Note: During these operations, a floating legend (called tooltip) with current size, size change and angle is 
displayed to help you to work more accurately.

When an object or block is selected, HotFix ERA activates the tab Layout within the ribbon (this
tab is the default when the block contains multiple objects).

The Layout tab contains a set of tools specially prepared for block operations:

Scale and Shape group

Rescale: This tool lets you define a segment in the object and then indicate
to system the size you need that segment to be. So, you can scale your
block considering the size you need for an specific shape on it (the height of
a given shape, the diameter of a circle, etc)
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Proceed this way:
1- Define the block
2- Activate the Rescale tool. Move the mouse pointer into the working area and click to set one
end of the reference segment and drag to set the end point.
3- When the mouse button is released, the scale box will appear. The measured length of the
defined segment will be highlighted and ready to accept your input. Just enter the size you want
and press OK. The block will be scaled so as the segment you defined now measures the size
you entered.

Rotation Angle: This tool operates quite similar to rescale. Once activated the system waits you
define a segment (click for start point and drag for end point ). Then, the rotation box appears with
the measured angle highlighted and ready for input. You just need to enter the desired angle and
press OK. The block will be rotated so as the defined segment has the entered angle. This tool is
very useful at the time of aligning a shape with the axes. Define the angle reference segment
aligned with the shape and then set the new angle to 0 or 90 degrees.

Rotate/Mirror : Simple tools that produce common fixed angle rotation (90, 180, 270 degrees)
and mirrors (vertical and horizontal).

Position and Size Groups

This groups contain  controls that  let  you set the position and size of
object blocks accurately. Just enter the desired value in the boxes and
press enter.

Align Group

This group contains tools for aligning objects respect other objects inside the
block and the hole block respect to the design.

To Object: This tools aligns the objects inside the block to left, right, top and bottom, using as
reference the leftmost, rightmost, upper and lower object of  the block. You can also align the
objects center horizontally, vertically or both.

To Design: Contains tools for align the whole block with respect to the design, that is, with respect
to all other objects not included in the block.

Center tool: Moves the center of the block to the system origin point (0,0).
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Repetitions

Access the available commands from the Block – Layout ribbon. In
the case of Hotfix design, you have only the Duplicate option.

Duplicate Block 
This  command performs a copy and paste of  the selected block in  only one step.  It
always works on the active document. 

Effects on Hot fix objects
OPTIONAL FEATURE

HotFix  ERA allows you  to  distort  a  block  following  complex  geometrical
patterns by means of the so-called effects. In the next paragraphs you will
find a description of these effects and the instructions on how to use them.

Note: Remember that the undo-command is always available, in case you want to undo after having applied an effect to a 
block. 

All the effects are available both from the ribbon BLOCK LAYOUT >
Create  Objects  group >  Effects  on  Hotfix  Objects,  and  from  the
context menu.

The  available  effects  are:  Move  Random;  Color  Random;  Color
Blending;  Hotfix  from  Grayscale;  Hotfix  from  Photo  Color;  Whirl;
Sphere and Grid Transformation.

Move Random OPTIONAL FEATURE

When applied to a block, some of the stones are displaced a distance that is 
configured from the Random Position Effect.
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The  result  show how  some  of  the  stones  have
been moved with no specific direction,  to add an
irregular look on the design.

Color Random OPTIONAL FEATURE

When applied to a block, some of the stones are replaced with the ones you have 
specified from the Random HF Type Effect box.

The result  shows how some of  the stones  have been replaced aleatorily with  some of  the
selected from the Random HF Type effect box.
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Color Blending OPTIONAL FEATURE

When applied to a block, the different color beads mix within the object. The amount of
beads of each color  depends on the relative location of the slider in the Effect box. 

The result shows how part of the stones have been replaced aleatorily with the other selected
color from the Color Blending effect box.

Grayscale Photo Stone OPTIONAL FEATURE

You need to have a Hot Fix object and an a grayscale image below. When you apply this
effect, the stones change their size following this premises:  dark gray, uses a big size 
stone; intermediate gray uses an intermediate size stone; light gray uses a little stone. 

Insert an image on the workarea. We used PSR-004.jpg available from
C:\Users\Public\Pictures\Sierra Technology\Artwork  Photo or through
the Catalog.

From the Hotfix ribbon, choose Area with HotFix - Flat Fill. To create
the area object, use the Round Rectangle from the Shapes item.

We used Beads and Rows spacing in 0,5 mm, Beads offset in 50%
and a Jet Color 10ss Rhinestone Round.
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Move the Area object you have just
created over the image.

From the Hotfix Area Layout ribbon,
Create  Objects group,  click  on
Effects  on  Hotfix  Objects,  and
choose  HotFix  from  Photo
Grayscale.

The Gray Scale Photo Stone FX box will open. On the left pane it shows all the colors the image
has. On the right pane, you will have all the beads defined on your system for this task. You have
to assign a bead to each color, to be able to use the Photo Stone tool. Proceed as follows:

On the right pane, click on a bead to
be used,  then  click  on  the color  on
the left pane to be replaced and press
the [<] button. 

The selected bead will appear on the
left  pane corresponding  to  the color
you chose.

Repeat  the  operation  will  all  the
image colors and press OK.

See the result on the right image. 

You get a design similar to the image you used, but made
out  of  different  size  but  same  color  stones,  that  are
displaced in the same way the Fill mode you selected. 
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Color Photo Stone OPTIONAL FEATURE

You need to have a Hot Fix object and an a image below. When you apply this effect, 
the stones change their color to the one most similar to the color of the image on the 
background. The result is getting a design very similar to the image below.

Insert an image on the workarea. We used ASR-006.bmp available
from C:\Users\Public\Pictures\Sierra Technology\Artwork Bitmap or
from the Catalog.

From the Hotfix ribbon, choose Area with Flexible Fill. To create
the area object, use the Round Rectangle from the Closed Shapes
item.

Next click on Add Direction,  and insert  a curve direction.  Press
Enter. You will get a result similar to the figure on the right.

Move the Area object you have just
created over the image.

From the Hotfix Area Layout ribbon,
Repetitions  group,  click  on  Effects
on  Hotfix  Objects,  and  choose
Photo Stone.

The Color Photo Stone FX box will open. On the left pane it shows all the colors the image has.
On the right pane, you will have all the beads defined on your system. You have to assign a
bead to each color, to be able to use the Color Photo Stone tool. 

Proceed as follows:

On the right pane, click on a bead to be used, then click on the color on the left pane to be
replaced and press the [<] button. The selected bead will appear on the left pane corresponding
to the color you chose.

Repeat the operation will all the colors and press OK.
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See the result on the upper right image.  You get a design similar to the image you used, but
made out of stones, that are displaced in the same way the Fill mode you selected. 

Whirl OPTIONAL FEATURE

This effect will allow you to deform an area of the block into a whirl. 

Move the mouse towards the Graphic View
area,  exactly  where  you  want  to  set  the
center of the whirl.  HotFix ERA will draw a
circle  while  you  drag  the  mouse  button,
hence  defining  the  diameter  of  the
transformation sector. 

Release the button when you are satisfied
with the result. 

If  you  want  to  modify  the  position  of  the
sphere, place the mouse pointer inside the
circle and drag to displace it. If you want to
correct  the  diameter,  drag  the  mouse
pointer  towards  the  outlines  of  the  circle
and drag it.

Intensity Selector: On the right side of the circle there’s a knob located vertically. Drag it up or
down to specify the intensity of the effect, and see the result in a dynamic way in the Graphic
View. To finish, press the Enter key or choose Accept/OK from the context menu. 
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Sphere OPTIONAL FEATURE

This effect will  allow you to deform the block, giving it a spherical shape. To use this
command follow the steps below:

The application over the block is similar to the
Whirl effect,  having  to  define  the  effect
intensity  from the  control  slider.  Click  inside
the design area and drag the mouse pointer to
determine  the  area  to  apply  the  effect;  you
can move it or change its size.

Apply  the  desired  intensity  from  the  right
control slider.
When you are satisfied with the result, open
the context menu and click on Accept / OK, or
simply press the Enter key.

Grid Transformation OPTIONAL FEATURE

This effect allows you to place the block on a rectangular grid. To form this grid, open the
context menu and add or delete rows or columns (next figure left), according to the result
you want to obtain. The rows and columns entered will be arranged along or across the
block, forming a grid.

Moving the grid’s points with the mouse (the intersection between rows and columns) you
deform it, while the block beads follow that transformation (next figure right). 
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Drag the grid’s points to obtain the desired shape, as you proceed deforming the grid, HotFix ERA
will  calculate the beads location, showing the result  on the Graphic View. To finish,  open the
context menu again and click on the option Accept / OK, or simply press the Enter key.

Object Manager and Object Inspector
The Object Manager is a special, technical view, that displays a “map” of your designs,
showing all the objects it contains: vector images, raster images and hotfix objects.
Access it Object Manager by clicking on its tab, to the right of the working area: A group
with two panels will open: the Document Map at the top and the Object Inspector at the
bottom. 
Object Manager is an important tool to check what objects the design has and it’s also a
method to select objects while Object Inspector is a detailed object’s properties editor.

Object Manager

The Object Manager (OM) is a special type of list known as a
“tree list”, much similar to the one used to display disk units,
folders, sub-folders and files.

The main items (the “parent” items, using the tree list language)
are the basic object types.

Hotfix  ERA works  with:  Images,  Vectors  and  Hotfix  objects.
Inside  them,  a  list  of  items  (the  “child”  items)  represent  the
loaded  images,  vector  artwork  objects  and  hotfix  objects
respectively.

Selecting  any  child  item  within  OM,  produces  the  synchronized  selection  of  the  object  it
represents within the graphic view and,  vice-versa, selecting an object within the graphic view,
selects the corresponding item within the OM.

Object selection is just one of many operations available from the OM: You can copy, paste, and
delete objects one by one or by blocks:

 Hold the Ctrl key and click items to create multiple selection sets; 

 Click an item, hold the Shift key and click a second one to select all items between them
in the list.

 Drag items (within the same parent group) to re-arrange their order within the sequence
(remember that object sequence may be meaningless for rhinestones, rhinestuds and
nailheads but may be important for sequins and spangles and also for vector objects).
The icons beside each parent group let you Block and Hide that object type: Blocking
an object  type makes impossible to select, delete or modify any object of that type;
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hidding an object type makes that type invisible.

Object Inspector

The Object Inspector is a complete browser and editor
for object’s filling properties.

It's organized as a categorized list with items arranged in
rows. Each row controls a property.

For  hotfix  Area objects,  Object  Inspector (OI)  displays
separated  tabs  for  body  and  borderline  fills;  for  path
objects, just the borderline tab is displayed

Rows in  OI  consist  in two columns:  one with  the  property name and icon  and one with  the
property value. Clicking the property value activates the property editor to modify the value. Once
activated, properties may display:

A down arrow to select the value among fixed options.
A spin button to increase/decrease value or type in directly.

Sorting pieces
A common practice when creating a design, is to proceed shape by
shape, building the required objects without paying attention to the bead
type each object use.  So, the resulting design sequence, that is, the
order of the objects as shown in the Document Map, follows exactly the
creation order. Due this, the design sequence is normally unordered in
terms of bead type, that is, not all the object using a given bead type
are placed one after another.

Sort Hotfix tool is designed to help you easily manage the design sequence, allowing automatic or
manually controlled object sorting.

The tool dialog is basically a list with items representing an
object or a group of contiguous objects that use the same
bead type. The item shows also the bead type it uses, its
current  position  within  the  design  sequence,  the  object
numbers it represents and a tiny icon of them.

The tool offers two modes: Sort by Palette Order (Automatic), that sorts the objects according to
the bead types they use by following the bead bar order (objects using bead #1 first, then objects
using bead  #2, and so on) and Manually, that allows you to order the items as you want.
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In manual mode, you may select any item and use the cursor keys to navigate through the list.
The arrow buttons at the top right allows you to move the item within the design sequence (you
may also use drag and drop to do it).

Once two object that use the same bead type are set contiguous, next time you open the Sort
Hotfix dialog they will be shown grouped into a single item.

Cleaning overlapped pieces
Most materials used in garment decoration with hotfix beads do not allow overlapped pieces. The
exception  to  this  rule  are  the  sequin  beads  type,  enough  thin  and  flat  to  allow  overlap.
Rhinestones, rhinestuds and nailheads instead, are too thick and curve to allow overlap.

When  objects  are  overlapped,  totally  or
partially,  beads  calculated  for  them  are
probably  overlapped too. The system will not
display any warning about this situation until
you try to export the design using any of the
output  formats.  At  that  moment  a  message
will notify you that the design has overlapped
pieces.

HotFix ERA  includes a tool to automatically cleans overlapped pieces
called Hotfix Conflict Window.  To launch the tool, you need to use the
button located in the  Hotfix ribbon >  Finishing Tools  group. This tool
requires you know some details about your design, basically, the order
of the objects in the design sequence.

When objects A and B are overlapped, one of them, let’s suppose A, is over B. This implies the
idea of object‘s sequence: A over B is different than B over A. Most of the time this situation
doesn’t care for hotfix designs, however, it cares when overlap conflict exists and when you use
overlapped sequins.

The object sequence is visible with the Object Manager view: the top most object in the list is
the first  object   created and the rest  of  them are over it  .  So, the rule is:  All  the objects
following a given one are over it.

The Conflict Window contains a tree list where each main item represents a conflict between
two objects and the items description declares what object is over what other. If you expand the
tree to explore the sub-list associated to each main object, you’ll find the overlapped beads,
one  by  one.  The check  marks  at  the  left  of  the  items let  you  include/exclude  them from
cleaning.
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At the same time, the graphic view shows red
crosses  for  each  bead  in  conflict  that  are
checked in the list. The toolbar at the top of
the  box  lets  you  Clean,  Refresh  the  list,
Check all items, Uncheck all Items, Expand all
list  and Collapse all  list  (mentioned in order
from left to right).
Check  the  conflicts  you  want  to  solve  and
press the Clean button. 

The system will remove the beads in conflict from the back object, preserving the beads of
the front object.

When all conflicts were solved or when there is no conflicts in the design, the Conflict List will
appear empty.

Importing YNG files OPTIONAL
FEATURE

This feature allows you to read hotfix YNG files produced with GemMaster ® version
2.9 and import the beads information into a DSG design file. This function imports
only  bead  information  (position,  type  and  color).  Design  objects  you  may  have
created are not imported.

To  import  YNG  files,  go  to  the  File>Open
ribbon, and from Import group, click on A Hotfix
File.

A standard  File  Open  dialog  appears.  Select
YNG Files (*.yng) from file type.

Navigate through your units and folders, point
the desired YNG file and press Open.

Reading  YNG  files  may  take  some  time  (a
progress bar is displayed during this phase).

Once finished, the YNG Import file dialog will be presented. This dialog allows you to define
which bead type, from the system's Beads Catalog, should be used for each bead type used in
the YNG file.

 4 - 41



HotFix ERA – User's Manual

There are two lists: The one at the left (Bead assignment) shows the bead types found inside the
YNG file, while the one at the right shows your current bead palette.

Two buttons at the top region of the box allow you to assign beads automatically:

Add to Palette: The system will search the Beads Catalog for beads  that best match in size and
color to the beads used in the YNG file. Once found, beads will  be assigned to the imported
design and they will be added to the current bead palette.

This mode keeps your current bead palette items, so it is recommended if you are importing a
YNG file into an existing design (so you will get a merged design). The bead palette will contain all
the bead types it previously contains plus the bead types used by the YNG file. If your palette
already contains a bead type used by the YNG file,  the existing one will be used (no duplicates).

Create New Palette: The system will search the Beads Catalog for beads  that best match in size
and color to the beads used in the YNG file. Once found, a new bead palette with them will be
created (your current palette will be lost) and its beads will be assigned to the imported design .

This mode is recommended if you are importing a YNG file into an new, empty design . The bead
palette will contain just the bead types used by the YNG file

Finally, you may also assign beads manually. Just select a row in the list at the left, and, using the
list at the right, click the green arrow to assign that bead to the imported design. 

The Edit button at the top of the Current Bead Palette list allows you to modify your current palette
to best suite the assignment needs.

Once you have completed the bead assignment task, press the OK button. 
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The YNG design will be loaded into your working area.

Beads will be imported as Manual Hotfix objects, grouped by sequences of the same bead type,
according to the bead order found in the YNG file. 

This arrangement facilitates bead type edition, scaling, etc.

Importing PLT files OPTIONAL
FEATURE

This  feature allows you to  read the hotfix  files created in  other applications and
stored in HPGL (PLT extension) as rhinestone stencils and import the information as
a design file DSG. The function imports only position information, size and color of
the holes. Design objects are not imported because the HPGL doesn’t include such
information.

To import  PLT files,  go to the Hotfix ribbon >
Insert  Hotfix  Objects  Group >  Insert  to  open
menu, and click on Insert a Stencil File.

A standard File Open dialog appears. 

Navigate through your units and folders, point
the desired PLT file and press Open.

Reading  PLT  files  can  take some  time  (the
system  displays  a  progress  bar  during  this
stage). After reading, the PLT File Import dialog
box is shown.

Reading PLT files can take some time (the system displays a progress bar during this stage). After
reading, the PLT File Import dialog box is shown. This box allows you to define what kind of
pieces (from the system catalog) is assigned to each part of the PLT file.

This box allows you to define what kind of
pieces  (from  the  system  catalog)  is
assigned to each part of the PLT file.

The box contains two lists: The left list of
beads  assignment,  which  shows  the
different types of  parts found in the PLT
file  and  the  right  list,  the  current  hotfix
palette.

You can assign beads types manually. To
do this, select a row in the list on the left
and click on the green arrow in the list on
the right for the part you want to assign.
The Edit button lets you adjust the palette
adding the parts you might need.
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Once you have completed the bead assignment task, press the OK button. 

The parts will be imported as manual hotfix objects, grouped by type of beads, according to the
order found in the PLT file. This structure facilitates subsequent type editing, scaling, etc.

Importing DST files OPTIONAL
FEATURE

This  feature allows you to  read the hotfix  files created in  other applications and
stored in DST (DST extension) as rhinestone stencils and import the information as a
design file DSG. The function imports bead quantity information, size and color of
the holes. Design objects are not imported because the DST doesn’t include such
information.

To  import  DST  files,  go  to  the  File>Open
ribbon,  and  from  Import  Group,  click  on  A
Hotfix File.

A standard  File  Open  dialog  appears.  Select
DST Files (*.dst) from file type.

Navigate through your units and folders, point
the desired DST file and press Open.

After reading, the DST File Import dialog box is
shown.

This box allows you to define what kind of
pieces  (from  the  system  catalog)  is
assigned to each part of the DST file.

The box contains two lists: The left list of
beads  assignment,  which  shows  the
different types of  parts found in the PLT
file  and  the  right  list,  the  current  hotfix
palette.

You can assign beads types manually. To
do this, select a row in the list on the left
and click on the green arrow in the list on
the right for the part you want to assign.
The Edit button lets you adjust the palette
adding the parts you might need.

The parts will be imported as manual hotfix objects, grouped by type of beads, according to the
order found in the DST file. This structure facilitates subsequent type editing, scaling, etc.
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Hotfix Text

This tool lets you create a hot fix object based on text characters using a library of predefined
fonts or the TrueType fonts you may have installed in your computer.

Texts  are  very  powerful  objects.  This  chapter  will  introduce  the  extensive  list  of  features
available in Hotfix ERA texts.

HotFix ERA Text Objects

When you create a path or area, you build the object shape using any of the creation methods:
manual, assisted, etc. Shapes for Text objects, instead, are built from characters you type, with no
need for graphic input: you just need to select the font, set the size (usually the text height) and fill
mode,  and type  the  characters:  HotFix  ERA creates  shapes  for  each  letter  and  applies  the
specified fill mode to them.

Text object types

There are two basic text types: those based on digitized fonts and those based on TrueType
fonts. 

Digitized fonts: Are quality pre-built fonts, included with the system. These type of fonts were
created, character by character, using special groups of basic objects (generally paths) and tested
for a range of sizes and bead types. When you create a text using a predigitized font, the system
uses those pre-built basic objects to generate the placement of beads.

TrueType fonts: Text based on TrueType fonts are built “on the fly”, using the shapes contained
in the font to automatically create objects for each character you type. Then, all objects created
for a given text are packed properly to allow easy manipulation and edition. It’s important to know
that not all  TrueType fonts have the same quality,  and not all  of  them are suitable for hotfix.
Proper selection of text size (basically,  related with the bead type you will  use) is the key for
getting good results.
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Creating Texts: Text ribbon

The Text ribbon contains most of the commands and properties you will use to create your hotfix
text objects. The following paragraphs contain a brief description of them, group by group.
Font : This group contains controls to select the font type (digitized or TrueType), the font itself
and the text height. For TrueType fonts, you can also select the font style: Bold and Italic.
Text: Inside this group you will find the box where you will type your text characters, the character
table (especially useful for digitized fonts, to know what characters are available in the currently
selected font), the alignment options (for multi-line texts), and the spell checker. For TrueType
fonts you may also activate the preview mode, forcing the system to display the typed characters
using the selected font, instead of the default one.
Spacing: This group includes controls to manage text spacing among letters, words and lines.
Body Fill – Border Fill: These groups controls the fill mode of the text object. Depending upon
the selected font, both groups or just one of them will  be displayed. Usually,  both groups are
presented for TrueType fonts and just one, Border Fill is displayed for digitized fonts.
Arrange: This group contains the commands to change the text layout, allowing you to arrange it
following simple layouts  like arc (upper,  lower  or both for multi-line texts),  stair,  etc.  or more
elaborated templates like bridge, diamond, etc.

Example: Creating simple text in 3 steps
In this example, we will create a 40 mm height hotfix text with the word “Sierra” using the digitized
font Blockletter and a golden rhinestud, 2 mm. diameter. See the procedure below as a basic
guide for creating texts:

Step 1- Select the font and text height

In the Font group, click Digitized Font. 
Then, click the Font button to open the font gallery
and select the font named Blockletter.
Click  the  height  control  and  type  in  40  if  you  are
using Metric system or 1.6 if you are using Imperial
system.

The  system  includes  a  standard  pack  with  10
digitized fonts. Additional  fonts may be available at
special prices upon request.
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Step 2- Set fill mode properties

The  font  we  have  selected  is  based  on  path
objects.  Due  to  this  fact,  the  system  displays  a
Border Fill group with the same fill mode properties
you find in a path object. 

Set  bead  spacing  to  0.5  mm and  select  a  gold
rhinestud 6ss (2 mm. diameter).

Step 3- Enter the text 

Using the box in the Text group, type in the word “Sierra” (with
upper and lower case letters). The system will play an error beep
sound  if  the  character  you  are  typing  is  not  available  in  the
selected font. 

You may also use the Character table button to check what characters are available.
Alignment controls will be enabled if the text has more than 1 line. To enter multi-line texts you
need to press “Ctrl + Enter” key combination to move the text cursor to a new line.
When you finish typing, press Enter. HotFix ERA will create the object text, displays it within the
working area. A box will surround the text leaving it ready for edition.

The handles on the letters and around the text let you change the text position, size and rotation
(use Ctrl to rotate) and letters size, position and spacing, graphically, by just dragging them.
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Editing Texts

One of the most useful features of text objects features is the persistence: Once a text object is
created it is preserved with all its properties and you may edit the font, size, words, fill mode, bead
type, size, position, etc.
Anytime you select a text object, HotFix ERA highlights it, shows the text handles and displays the
text ribbon, allowing edition of text properties and geometric aspect.

Editing Text Properties
The text  ribbon is the main tool  to edit  text  properties.  Any property displayed there may be
changed and the object in the graphic view will immediately reflect that change.
Using the  Font group you may edit the font, style and height; using the  Text group you may
change the letters and alignment; the Spacing group lets you modify the characters, words and
lines spacing; the Fill mode group (Body, Border or both of them) allows edition of bead type and
fill style and finally, the Arrange group, allows changes in text layout and effects.
The Object Inspector may be also used to edit the fill mode properties.

The Text dialogue-box

At the bottom right corner of the Text group you may note a small icon. Clicking
on  it  displays  a  dialog  box  with  text  properties  related  with  the  font  and
characters.

The box contains pictures that  clearly show the meaning of  many of  the text
properties.
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Editing Text Geometry

As mentioned, when you select a text object, HotFix ERA displays a box and a set of handles on
each letter and around the text. 

Most of the handles around the text box
operate in the same way that the handles
around  any  other  object:  dragging  the
corner  handles  scales  the  object
proportionally, keeping the opposite corner
in place and dragging the handles located
at the middle of the sides, scale the object
horizontally  or  vertically,  keeping  the
opposite side in place. 

If you hold the shift key while dragging, the position of the object center is kept, and if you hold the
Ctrl key, you may rotate the object and/or change the position of the rotation center.

Text objects have an additional handle located on the right side, between the lower and middle
handles, called the spacing handle. Dragging it you may proportionally scale the letters and words
spacing.

Handles on letters allow control of letter size and position in a
per-letter basis. 

Dragging the handle near the letter baseline (a) moves the letter
horizontally; the middle handle (b) moves the letter vertically and
the corner handle (c) scales the letter. 

In the example, letter “r” was scaled up using the corner handle
and move a bit up with middle handle.

Text Transformations

In the previous section a simple geometry edition tool was presented that basically allows you to
scale and rotate texts. 

This section introduces tools that let you produce more flexible geometry manipulation: they are
the text transformation types.
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Transformation types
HotFix ERA allows two basic types of text transformation:

Envelope Transformations: Are based on the distortion of the box that contains the text.
For example, bending the box containing the text produces an arc layout. Characters
are distorted according to the envelope distortion.

Line Transformations: Are based on the distortion of the line where characters lie. For
example, tipping the baseline produces a stair layout. Characters are not distorted; just
their position is modified.

In addition to this classification, HotFix ERA organizes the transformation in two groups: Defaults
and Templates. You can access them from the Arrange group.

Default  transformations  are  simple,  basic  transformations  like
Rotation, Irregular, Arc (upper and lower) and Stair.  Using the
default  transformations  you  may  build  envelope  and  line
distortions with any shape. 

Templates: Although using the default transformations you may
create transformations of any shape, the system includes a set
of pre-built shapes, so you don’t have to do it by yourself. They
are called Templates. Shapes like Bridge, Panoramic, etc. are
included within the templates.

Using Transformations
All  transformations have a number of  handles or  grips to  control  them. Depending  upon the
transformation, the system displays different handles that produce different effects. The following
examples describes the behavior of the handles of some default transformations.

Stair (Step Text)

Stair  transformation has three basic handles located at
the right side of the text.

Handle A controls the angle of the baseline. Drag it down
to get a descending stair; drag it up to get an ascending
one.

Handle B changes text spacing proportionally.

Handle C produces a proportional scaling.

When you move the mouse out of  the handles,  a four
arrows  pointer  shape  indicates  that  you  may  drag  to
move the whole text.
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Upper Arc

Lets you bend the text in an arc shape. The handles to control this transformation are:

Handle A: controls the vertical
size of the transformation box,
keeping  the  superior  arc  in
place  and  moving  the  lower
one.

Handle  B: Controls  the  horizontal
size of the box, but preserving the arc
shape.

Handle  C:  Controls  the
distance  of  the  box  from the
arc center.

Handle D: Also controls the vertical size of the box, but it preserves the lower arc and move the
upper one.

Handle E: Scales the whole box, combining the effects of handles B and D.

Handle F: Rotates the box around the arc center.

Handle G: Controls the arc radius.

Lower Arc

Lets you bend the text in an arc shape. The handles to control this transformation are:

Handle A: controls the vertical size
of  the  transformation  box,  keeping
the lower  arc  in  place and moving
the upper one.
Handle  B: Controls  the  horizontal
size of the box, but preserving the arc
shape.
Handle C: Controls the distance of
the box from the arc center.

Handle D: Also controls the vertical size of the box, but it preserves the upper arc and move the
lower one.

Handle E: Scales the whole box, combining the effects of handles B and D.

Handle F: Rotates the box around the arc center.

Handle G: Controls the arc radius.
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Irregular Box

Allows free distortion, with no predefined geometric shape. When you select this transformation,
the system activates handles at the corners and at middle point of the sides.

Handles in this transformation have three states: free,
straight and curve. 

State may be changed right away by clicking on them
with the mouse right button.

Changing handles state allow you to get different box
distortions, like the one showed in the picture above.

User line and User Distortion

These transformations are available at the time of creating the text object only. When you edit a
previously created text, none of them are available.
To use these transformations, you need to select them after typing the text but before pressing
Enter, from the Arrange group of options.

The  User  Line,  allows  you  to  freely  create  the
baseline where text characters lies. Each click sets
a straight node of the baseline; Shift + click, sets a
curve node.  The backspace key deletes the last
node. Hit Enter to finish baseline definition. 

HotFix ERA will create the text placing the characters along the baseline created.

The User Distortion lets you create two lines, one
at the base and one at  the top,  using the same
procedure that  the one for  User  Line.  Both lines
define a box used to distort the text. The first line
you enter  will  be the box base line.  Hit  enter  to
continue with the box top line and hit Enter again to
finish.

NOTE: top and bottom line nodes must be inserted
from left to right.
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Exploding Texts (Split Hotfix)

The term Exploding is used to make reference to the action of converting text objects into its
primitive basic objects: paths and areas.

Once a text object is exploded, edition as text is no more possible but, you get total control over
the shapes and properties of the objects used to build the text characters.

To explode a Hot Fix text object:

1- Select the text.

2- Access the context menu and select Split Hotfix Text command.

Now that you have exploded the hotfix text, you can edit the paths and areas, to be able to add
nodes, modify shapes, and change beads size and color, among other things.
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Assemble Hotfix Beads

The term Assemble is used to make reference to the action of gathering hotfix objects into only
one hotfix manual section.

To Assemble HotFix Beads:

1- Select the hotfix objects or text.

2- Access the context menu and select Assemble Hotfix Beads command.

Now the text has been turned to Manual Hotfix and its gathered in only one manual section. You
can change the color to all the beads in one blow, or move them to another location. In the
Object Inspector you will find one entry that says Manual Hotfix.
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Disassemble Hotfix Object

The term Disassemble is used to make reference to the action of separating a hotfix object, text
or assembled hotfix beads into separated hotfix manual beads.

It's very useful when you need to have one or several colors and to avoid havong to change the
color to each bead, one by one.

Once you have all the manual beads, you can make one or several blocks of manual beads.
Now you can select each block, press Assemble Hotfix beads, and the result will be that this
block of  manual beads,  will  be gathered into  only one Manual  Hotfix  entity.  Then you can
change the bead size or color to it and/or move it.

To Disassemble HotFix Objects:

1- Select the hotfix objects or text (first apply the Divide Text command).

2- Access the context menu and select Disassemble Hotfix Objects command.

Now  the  object  has  been
turned into  a lot  of  Manual
Hotfix pieces.

You can select a block and
Assemble  them  as  one  to
be able to move it or change
its color.

We  assembled  the  beads,
that  make  the  letters  V,  E
and  R,  and  then  we  have
changed  the  color  and  the
stone.  We  assembled  two
more groups.

 See them in the document map. We have applied a rotation to the middle assembly.
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At the time to set a hotfix design on a garment, you will  need to use any of the known hotfix
technique methods. From the manual method to the automatic setting machines, you will need to
get information about the beads type and position for your design. At this point, the output formats
become very important.

This chapter is dedicated to the output methods available in HotFix ERA. Basically,  there are
outputs for stones, outputs for sequins and outputs for spangles. In case of stones, some outputs
are prepared for direct to garment technique and others for transfer technique. The system is also
able  to  send  information  to  CAMS automatic  settling  machines  (connected  to  the  computer
through serial  port),  to  most  Windows  compatible  vinyl  cutters  (those  that  have  an  standard
Windows driver) and to HPGL compatible cutters with serial port interface.

Please note that most of the output methods are optional features. Your system may have one or
two of them activated but not all of them.

Hotfix ERA Outputs OPTIONAL
FEATURE

The following tables lists all the output modes available. Output formats based on files;  and the
ones related with  direct connection to machines or devices are obtained using the File ribbon >
Save - Export  group > Hotfix → Export As...
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You can also output your design from the Hotfix ribbon > Export  group...

File Formats
The file exported by the system should be transported to the machine using the available method
(USB pen drives, disk, etc) as specified by the manufacturer.
Stones:

Output Format Intended for

Hotfix Stone file for CAMS® SRT file format for CAMS® stone  machines. File should be
transported using the pen drive interface (*)

Hotfix Stone file for GemFix ® TJC file format for GemFix ® stone setting machines (*)

Hotfix Stone file for N&H ® ASC file format for N&H ® stone setting machines (*)

Hotfix Stone file for Salli ® SHF file format for Salli ® stone setting machines (*)

Hotfix Stone file for NCK ® DST file format for NC Korea ® stone setting machines (*)

Hotfix HPGL File PLT file with standard HPGL format for use with cutters and
milling machines to create stencils. May require some post-
processing with machine specific software.

The term Stone is used to refer to Rhinestones and other type of hotfix pieces the machines may
support like rhinestuds and nailheads.
Sequins:

Output Format Intended for

Hotfix Sequin file for Salli ® DST file format for Salli CSM® sequin setting machines. (*)

Hotfix Sequin File for SWF® DST file format for SWF-M® sequin setting machines. (*)

Hotfix Sequin File for NCK® DST file format for NC Korea® sequin setting machines. (*)

Spangles:

Output Format Intended for

Hotfix Spangle file for NH® ASC file format for N&H ® spangle setting machines.(*)

Hotfix Spangle file for Coldesi DST file format for Coldesi spangle setting machines.(*)

 6 - 3



HotFix ERA – User's Manual

Hotfix Spangle file for Technics ASP DST  file  format  for  Technics ASP  spangle  setting
machines.(*)

All hotfix types:

Output Format Intended for

Hotfix Windows Metafile EMF file format with filled shapes for all  hotfix type pieces
contained in the design. This format may be imported with
graphic software like Adobe Ilustrator, CorelDraw, etc.

Hotfix DXF file DXF standard format with the shapes for all hotfix type pieces
contained in the design. This is a popular interchange format
used in  CAD systems and also  in  some CNC and milling
machines.

Hotfix SVG File SVG file format with filled shapes for all  hotfix type pieces
contained in the design. This format may be imported with
graphic software like Adobe Ilustrator, CorelDraw, etc.

(*)  Format  suitable  for  most  models.  Please,  ask  your  dealer  for  a  sample  file  to  check
compatibility with your specific machine.

Mentioned brands and trademarks belong to their respective owners.

Send to machines and devices

Output Format Intended for

Send To CAMS® Sends  hotfix  stone  design  data  to  CAMS®  machines
connected to the computer through the serial port.

Send To Windows Cutter Sends  hotfix  stone  contours  information  to  Windows
compatible vinyl cutters to create stencils. Usually, a software
driver provided by the device manufacturer is required.

Send To HPGL Serial Device Sends  hotfix  stone  contours  information  to  any  standard
HPGL compatible device connected to the computer through
the serial port.

Send to Engraver Sends  hotfix  stone  contours  information  to  Windows
Compatible engravers connected to the computer.

Send to Technics ASP® Sends hotfix sequin design data to Technics ASP® machines
connected to the computer through the serial port.
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Printing

Standard printing to any Windows compatible printer is also available. This output type may be
used for reference, for manual beads placement and for customer presentations.

Exporting Hotfix files

The commands to export stone files to the different formats are accessed through  the the  File
ribbon > Save > Export > Export As... > Export/Send HotFix File or from the Hotfix ribbon > Export
group  > Export Hotfix to machine. 

Remember that Output Formats are optional plugins, so the list may
contain just one or two formats depending on what formats you have
purchased.

A dialog box named HOTFIX EXPORTER will open.

The following sections contain details about this box.
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Machine Brands and Models Supported

Machine Brand Machine Model

Coldesi Spangle (DST) Spangle Elite

DS-Tech Stone RSM (MACH) DS-400-6C

GemFix Stone (MACH) GEM4023 / 3040 / 5550-2/2 / 5550-4/2

Generic Machine (DST) Generic 400

Nagel & Hermann Spangle LIBERO (MACH) Sequin Libero

Nagel & Hermann Stone ALLOVER (MACH) Allover 059 / 1600 / 3200

Nagel & Hermann Stone LIBERO (MACH) Libero Basic/Sheet/R/A/B/C/C8

NCK® Sequin DECOS (DST) DECOS  S42-4C  (400x400)  /  DECOS  S42-4C
(400x480) / DECOS S42-M4C / DECOS S42-M6C

NCK® Sequin DECOS (MACH) DECOS  S42-4C  (400x400)  /  DECOS  S42-4C
(400x480) / DECOS S42-M4C / DECOS S42-M6C

NCK® Stone DECOR (DST) DECOR S40V-1H4C (400x400) / DECOR S40V-1H4C
(400x480) / DECOR S40V-2H6C (400x400) / DECOR
S40V-2H6C (400x480) / DECOR S30V-1H2C

NCK® Stone DECOR (MACH) DECOR S40V-1H4C (400x400) / DECOR S40V-1H4C
(400x480) / DECOR S40V-2H6C (400x400) / DECOR
S40V-2H6C (400x480) / DECOR S30V-1H2C

Salli Stone ASM (DST) Salli ASM-6C-01H

Salli Stone ASM (MACH) Salli ASM-6C-01H

SWF Sequin SERIE-M (DST) SWF Sequin

Technics Spangle ASP (DST) ASP-Compact / 645-2 / 645-4

Technics Spangle ASP (MACH) ASP-Compact / 645-2 / 645-4

Technics Stone (DST) Combi

Technics Stone (MACH) Combi

Yongnam Machines - CAMS CAMS 1V 2P / 1V 6P  Basic – Option – (400x300) / 4H
3P / 2V 12P
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Hotfix Exporter

All the output formats based on files use the same dialog box, named HOTFIX EXPORTER. 

Under  Machine,  you  have  a
drop down menu to select its
Brand and Model. 

Output  type allows  you  to
mirror your design horizontally
or vertically if needed. 

You  can  see  two  common
tabs:  Position and  Beads and
Trays. 

Position gives you information
about your work area; lets you
set your margins, and also to
change the design orientation.
You  can  also  add  some
repetitions.

For machines using DST file format, such as Coldesi, NCK, Salli, SWF and Technics, Position
refers to the  starting point of the design; while for the rest of the machines, Position refers to the
location of the design in the machine working area. The tab also contains a preview panel and
general information about the design (name, size, and beads count) and machine features (max
area, number of beads trays, etc).

The Bead and Trays tab contains a list with all of the bead types used in your design. The check
in the first column allows you to include/exclude that piece type from the output. 

The Quantity column gives you the exact pieces to be used, so you are aware of the amount you
will need to have on your tray.

The Page column lets you decide whether  to have all  the work on one page or to divide it
conveniently.

The Dev. column lets you select the tray where the bead type is loaded in the machine (available
for machines with several trays).

On the Angle column you can specify the orientation of the beads if they are not round.

On the right  pane  Multiple pages /  files  you have information about the Page arrangement,
showing  which  beads  appear  on  each Page,  according  to  what  you  selected  on  the  Page
column.
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On  the  lower  part,  there  are
some  extra  options  with  check
boxes for you to enable / disable
if needed:

Calculate  best  route;  Invert
beads order; Sort by bead type.

These  options  work  only  for
some brands and models.

Calculate  best  route lets  you
enable  an  optimization  process
that  minimizes  machine  travels
within the design. 

Sort by bead type, gathers all objects that use the same bead, that may be not contiguous, so
they are executed at the same time. Invert beads order is used when working with transfers and
there's a forced overlapping in the design, where the second stone may be over the first one, and
if transferred, would change order unwittingly. 

On the lower left corner of the Hotfix Exporter window,
you will  find a button  View Export  Reference. It  will
show  you  the  design,  type  and  number  of  pieces
needed,  and order (right capture).

Finally, when you press the Export button, a standard
Windows select file dialog box will appear. Select the
destination file name, folder and disk unit. 

Once saved to your disk, you will need to transport the
file to the machine using the procedure indicated by
the machine manufacturer.

In the case of CAMS machines, appart from exporting the files using the HotFix Exporter dialog
box, you can Send them directly to the machine from there too. This is achieved just by placing a
check  mark  in  the  option  Send  to  Serial  port,  that  becomes  available  when  selecting  that
machine type. You will find precise information on how to Send to CAMS machines further in this
chapter.
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Exporting to HPGL, Metafile and DXF Files

This  command  allows  you  to  save  hotfix  stone  designs  from  the  working  window  as  a
template/stencil in file formats that are compatible with cutters or other applications.

To  export to the different format  files,
go to the File ribbon > Save > Export >
Export  As...  >  Export  HotFix
Template/Stencil as....

or  from  the  Hotfix ribbon  >  Export
group  > Export Hotfix to file 

The HotFix Export To window will open. From the list choose the Save option you need. You can
choose among: Save to HPGL; Save to DXF; Save to SVG and Save to Metafile.

Export to HPGL File

HPGL files are a very popular format for cutting
and  milling  machines.  The idea  is  you  export
this format to cut  stencils for  hotfix placement
using  the  template  technique.  By  default,  you
should export  a different file for each different
bead type your design uses. However, stones of
very  different  sizes  may be  grouped  into  one
stencil, as long as you set the largest one first
and then the smallest one.

When you  select  the  command  Export  HPGL
file, the system opens the dialog shown  on the
right, which is organized in two tabs: 

Page  design:  This tab contains controls to set
the page size, design position and resolution. 

Beads: This tab includes a bead list, where you define what bead types are included in the
exported file and select the Pen number and margin; and a list of Pages where you organize
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what beads are included in each page.

On the lower  part,  you  have three options that
allow you to include or not a frame around the
design; and to be able to cut a figure around the
beads to avoid wasting a lot of stencil material.

If  you  enable  Figure  cut,  a  new  tab  named
Vectors will appear (as seen on right capture).

This tab will show the vector figures made around
the pages in which you divide your design.

On the example next, we made a bike out of four
hotfix objects.

We will divide the design in two, by defining two
vector figures: one for the body and head and the
other for the bike's wheels. 

First change the vector images property from  Auxiliar tab to  Cutter tab, just by selecting each
image and pressing the Cutter button on the Artwork-Vector ribbon > Used as group.

After checking Figure cut, go to the Vectors tab. You will see the vectors drawn before. Select the
corresponding page in which they will be enabled and press the preview button to see the result.
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You will save a considerable amount of stencil material, by using this feature.

The Pen parameter is common for plotters and
milling machines.

Margin  is  a  value  used  to  enlarge  the  mark
exported for a given bead type,  so the piece
can be easily trapped by the stencil hole.

To  organize  pages,  just  drag  the  bead  from
any page to any other: this action will produce
pages with  several  beads and pages with  no
beads (with a red cross). 

The  system  will  generate  a  different  file  for
each page listed, but pages with the red cross
(no beads) will be skipped.

When you press  Save, the system displays a Save dialog where you indicate the path and file
name for the  PLT file. If  multiple files are generates, the systems will  automatically append a
number  “-1”, “-2”, etc. to the file name.

Export to Windows Metafile and DXF formats

Windows Enhanced Metafile (EMF), is a vector based  format well suited to be used with graphics
applications like Adobe Ilustrator and CorelDRAW. The system exports the beads contours as
closed filled shapes using colors similar to the bead color. The Export to Metafile dialog box looks
and behaves identical to the Beads tab of the Export to HPGL  box.

DXF is a standard vector format commonly use as CAD interchange format. It is also used in
some engravers, CNC and milling machines. The system exports the beads contours as straight
sides polygons. The Export to DXF dialog box looks and behaves identical to the Beads tab of the
Export to HPGL box.
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Sending Hotfix to machines and devices

Through  this  command  you  can  send  hotix  stone  designs  form  the  working  window  as  a
template/stencil to several machines and devices.

Access it from the File ribbon > Save > Export > Export As... > Send Hotfix Template/Stencil to...

or from the Hotfix ribbon > Export group  > Send Hotfix

When you click on the option,
a window will open.

You have three Send options
to choose from:  to  Cutter;  to
HPGL; and to Engraver.

Click on the option you want.

Remember that Send Formats are optional plugins, so the list may be empty or contain just
one or two items depending on what formats you have purchased.

TIP: If  you  plan  to  produce  stencils  (using  a  vinyl  cutter  or
engraver) it may be useful to display, not only the piece contour,
but  the piece margin as well.  Piece margin is used to  cut  or
engrave a notch slightly larger than the piece itself  to allow it
easier fit in. Use  the check at Option and Preferences - Project -
Hotfix - Show hotfix margin  to enable or disable the marging
display. Use  Hotfix margin size to set the value of the pieces
margin.
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Sending information to CAMS machines

The command for sending a design to CAMS is accessed
through  the  File  ribbon >  Save  -  Export  group >
Export/Send HotFix File or from the Hotfix ribbon > Export
group  > Export Hotfix to machine 

The dialog box named HOTFIX EXPORTER opens.

From Machine Brand select  Yongnam Machines – CAMS;
and from Model choose the one you want.

You can see two tabs: Position and
Beads and Trays. 

Position gives  you  information
about your work area; lets you set
your  margins,  and  also  to  change
the design orientation. You can also
add some repetitions.

The  Bead  and Trays tab  lets  you
set the machine tray that should be
used  for  each  bead  type  and  the
default  angle  for  the  beads
(required  for  CAMS  1V6P  Option,
that  is  able  to  set  pieces  in  any
angle).  Also  a  check  in  the  first
column lets you include or exclude
any given bead from the output.

The Tray column lets you select the
tray where the bead type is loaded
in  the  machine  (available  for
machines with several trays). 
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On the lower right corner you will  see a check box, that
says Send to Serial port.  If you do not check it and press
the Ok button, a standard Windows select file dialog box
will appear in order to allow you to select the destination
file name, folder and disk unit. 

Once saved to your disk, you will need to transport the file
(*.srt) to the machine using the procedure indicated by the
machine manufacturer.

If you check the box, then the system will display the  Serial Transmission dialog box:

You will  need to  select  the COM port  where  the  machine  is  connected  and check  that  port
transmission speed  (Config button,  Bits  per  second value) matches the machine connection
speed. Data bits should be set to 8, Parity to none, Stop bits to 1 and Flow Control to hardware
(these are the values used by CAMS machines).

Finally, prepare the machine to receive data and press the Send button. Design information will
be sent to the CAMS machine and stored in it.

Sending information to Windows Cutters

Vinyl  and  laser  cutters  are  the  preferred
tools to create stencils for hotfix application.
Most of them includes a Windows driver, so
they  are  usually  installed  and  listed  by
Windows as printers. The drivers also allow
control  of  pen  speed,  pressure  or  power,
media size, etc.

Access  it  from  the  File ribbon  >  Save >
Export  group> Hotfix-Export  As...  >  Send
Hotfix Template/Stencil to...

or from the Hotfix ribbon > Export group  >
Send  Hotfix  and  click  on  Send  Hotfix  to
Cutter

The system will  open the dialog shown  on
the right.  
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You will save a considerable amount of stencil material, by using this feature.

It’s organized in two tabs: 

Page  design:  This  tab contains  controls
to set the origin. Media size should be set
from the driver.

Beads: This  tab  includes  a  bead  list,
where  you  define  what  bead  types  are
included in the exported file, margin, and a
list  of  Pages  where  you  organize  what
beads are included in each page.

Margin is a value used to enlarge the mark
exported  for  a  given  bead  type,  so  the
piece can be easily trapped by the stencil
hole.

To organize pages, just drag the bead from any page to any other: this action will produce pages
with  several  beads and pages with  no beads (with  a red cross).  The system will  generate a
different file for each page listed, but pages with the red cross (no beads) will be skipped.

On the lower part, you have three options that allow you to include or not a frame around the
design; and to be able to cut a figure around the beads to avoid wasting a lot of stencil material.

If you enable Figure cut, a new tab named Vectors will appear (as seen on right capture).

This tab will show the vector figures made around the pages in which you divide your design.
On the example next, we made a bike out of four hotfix objects. We will divide the design in two,
by defining two vector figures: one for the body and head and the other for the bike's wheels. 

First change the vector images property from  auxiliar tab to  cutter tab, just by selecting each
image and pressing the Cutter button on the Artwork-Vector ribbon > Used as group.

After checking Figure cut, go to the Vectors tab. You will see the vectors drawn before. Select the
corresponding page in which they will be enabled.
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You will save a considerable amount of material, by using this feature.

When you press Send, the system will display the standard Print dialog where you need to select
the cutter device and, through the Properties button, set media size, pen properties, etc. When
you accept the Print dialog, a small box will prompt you to click Ok when the device were ready. 

Load and align the media in the device and press OK to start cutting. This sequence will  be
repeated for each page in the output.

Sending information to HPGL compatible devices

This  output  is  suited  for  those  standard  HPGL  compatible  devices  with  no  Windows  driver
available that are connected to the computer through a serial port.
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Access it from the File ribbon > Save > Export
group>  Hotfix-Export  As...  >  Send  Hotfix
Template/Stencil to...and click on Send Hotfix
to HPGL Compatible Device

or  from the  Hotfix ribbon >  Export group  >
Send Hotfix and click on Send Hotfix to HPGL
Compatible Device.

The system will open the dialog shown at the
right. 

It’s organized in two tabs: 

Page design: This tab contains controls to set
the media size and origin. 

Beads: This tab includes a bead list, where
you define what  bead types are included in
the exported file and select the Pen number,
and margin,  and a list  of  Pages where you
organize  what  beads  are  included  in  each
page.

Pen is a  common parameter for plotters and
milling machines.

Margin is a value used to enlarge the mark
exported for a given bead type, so the piece
can be easily trapped by the stencil hole.

On the lower part, you have three options that allow you to include or not a frame around the
design; and to be able to cut a figure around the beads to avoid wasting a lot of stencil material.
This part has been explained in previous pages.

To organize pages, just drag the bead from any page to any other: this action will produce pages
with  several  beads and pages with  no beads (with  a red cross).  The system will  generate a
different file for each page listed, but pages with the red cross (no beads) will be skipped.

When you press  Send, the system will  display the Serial
Transmission dialog box... select the COM port where the
device is connected and check that port settings (Config...
button) matches the device connection settings.
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When you press Send, a small box will prompt you to click
Ok when the device were ready. 

Load and align the media in the device and press ok to
start data transmission. 

This  sequence  will  be  repeated  for  each  page  in  the
output.

Sending information to Engravers

This  output  is  suited  for  those  engravers,  CNC and  milling  machines  that  have  a  Windows
compatble driver (listed as standard printers). Using it, you may create the stencils required to
produce hotfix design using that method.

Access it from the File ribbon > Save > Export
group>  Hotfix-Export  As...  >  Send  Hotfix
Template/Stencil to...and click on Send Hotfix
to Engraver.

or  from the  Hotfix ribbon >  Export group  >
Send  Hotfix  and  click  on  Send  Hotfix  Send
Hotfix to Engraver.

The system will open the dialog shown on the
right. 

It’s organized in two tabs: 

Page design: This tab contains controls to set
the  media  size  and  origin.  You  may  also
indicate  to  include  alignment  marks.  In  this
case, you should define the tool number to be
used  to  engrave  the  marks,  the  marks
diameter  and  the  distance  from  the  design
boundaries to the marks.
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Beads: This tab includes a bead list (top-left) a
tool list (bottom-left) and a pages list (right)

Using  the  Bead  list  you  define  which  bead
types will be send to the engraver, a marging
(enlargement)  to  allow the bead to  be easily
trapped into the hole made by de engraver and
the  tool  (as  a  color)  that  should  be  used to
engrave the marks for each bead.

The Tool list lets you set the size of each tool
used within the bead list.

The  Pages  list  lets  you  control  which  bead
types will be included within each engrave run
(or “page”). You may include all the bead types
within one unique page or you may split the job
into  so  many pages  as  different  bead  types
your design uses.
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Smart Design
This tool accelerates the activities related with the objects creation and objects editing, as it is
described below, as well  as some functions related with auto-digitizing. This means that Smart
Design  has  different  functionality  depending  on  the  moment  it  is  used,  but  in  every  case  it
simplifies the steps of the sequence necessary for such activities.

Press the “Smart Design” button to open the Smart Design tool, located
on  the  auxiliary  toolbar  (below  the  main  ribbon  and  above  the
workspace area).

The tool will open as shown in the left figure.
The  Smart  Design  tool  includes  different  types  of
objects with their respective fill modes.

The number of objects and fill modes depend on the
purchased  software  product,  as  more  advanced
systems include more types of objects and fill modes.

Thus, the objects and fill modes shown here may be
not included in your product.

Smart Design in Objects Creation mode
When there is no object selected on the working area, the Smart Design tool works in the Objects
Creation mode.

From the list of options available in the Smart Design tool, select the type of object with the fill
mode you want to use to create a new object. Then start digitizing the object on the working area
right away. When you finish, press Enter. So simple!

When that object creation ends, select any other object type from the Smart Design tool, and start
a new object again. Really simple.

You can also use the included Shapes from the Digitizing Method group. Once you select the type
of object with the fill mode you want to use, click on Shapes to view the available ones. Select one
and then make a rectangle on the workspace area. When you are satisfied with the size, release
the left  mouse button.  Press Enter to generate the beads. In the example next we used the
musical note found in advanced shapes.
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When you select the type of object in the Smart Design tool, the ribbon bar on the top of the
workspace toggles to the tab that includes the properties of the selected type of objects, where
you can edit the characteristics of the object you are creating.

Note: 

This function replaces and simplifies the sequence of steps to select the type of object and fill
mode: HotFix Tab > Object Type > Fill Mode.

Smart Design in Object Editing mode
When there is a selected object in the workspace, the Smart Design tools works in Object Editing
mode. This means that if you click on one of the available modes, the Smart Design tool quickly
converts the fill modes of the objects selected to the one you clicked on. You may also convert
between some object types.

7-3



Hot Fix ERA - User's Manual

Select a hotfix object from the workspace. 

The object properties are shown on the ribbon bar, on top of the workspace. 

Press the type of object and fill mode to be converted, from the list of available options in the
Smart Design tool.

After the conversion is done (when the selected conversion is an available option) that object will
be of the new type and fill mode.

The ribbon bar will show the properties of the new object type, where the characteristics can be
edited.
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Note:  Not all the type of objects can be converted to any kind of object types. In some cases the conversion cannot be
performed, and in some cases the conversion process may loose some of the objects characteristics (direction lines, and
other elements).

Important: On the software products containing both decoration modes hotfix (rhinestone or
sequin)  and embroidery  simultaneously,  this  tool  may also convert  rhinestone (or  sequin)
objects into embroidery objects and viceversa. 

Smart Design in Vectors Digitizing mode
When there is a vector shape in the workspace (from a vector graphic application), the Smart
Design tools works in Auto-Digitizing mode. In this case the Smart Design tool creates an object
(embroidery or hotfix, according to the software features) with the shape of the selected vectors.
This is the fastest way to create objects when the artwork comes from vector files.

The vector shapes may come from vector files made on other graphic applications, from art stock
collections,  from  vector  shapes  created  on  this  application  and  also  from  the  result  of
vectorization of raster (bitmap) files.

7-5



Hot Fix ERA - User's Manual

Load the vector image ASV-010.emf from the Artwork ribbon > Vector group 
> Open Vector File. The image is on the following location:

C:\Users\Public\Pictures\Sierra Technology\Artwork Vector

As it may probably be a composition of many combined graphic elements,
you need to  Ungroup All the elements of the image (function on the ribbon
bar while the image is selected).

After ungrouping, check the created geometric shapes (vectors).
If required, use the combination tools (to simplify the shapes).

Once we have the final vectors, we may start auto-digitizing. 
Work on each vector, one at a time.

Click on the body of the peach
to select it.

Now click  on  the Smart  Tool,
on the object type and fill mode
you want to use. 

The  Smart  Design  tool  will
create the new object, with the
shape  of  the  selected  vector,
using the fill mode you chose.

Next,  we  selected  the  peach  contour
vector, and chose HF Path to create the
new  object  (near  right  figure).  We
changed the color to black by clicking on
the  black  bead  on  the  bead  palette.
Change  Properties  if  needed  from  the
ribbon.

Repeat the procedure for the remaining
vectors. See the final result on the figure
on the far right.
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